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ormally this section of MXDJ 
has articles on specific features, 
best practices, or develop-
ment topics du jour. Diving 

into the great new tools and features is 
necessary and helpful, but aside from the 
sheer excitement of digging into new 
technology, why bother designing and 
developing with rich media in mind? From 
a business standpoint, does it really pay 
off? According to key organizations, the 
response is an absolute “yes,” and the data 
is rolling in to prove it.
	 Previously regarded as experimental, 
expensive, or difficult to implement, rich 
media-centric Web sites are now critical to 
companies’ business strategies. Gartner’s 
research found “Companies that empha-
size customer experience as a strategic 
objective enjoy up to 60% higher profit-
ability and are twice as likely to exceed 
analyst expectations.” A university study 
concluded that products displaying inter-
active features are 70% more likely to be 
purchased than products with static imag-
es. And for companies doing online adver-
tising, industry leader DoubleClick found 
that organizations saw an 80% lower click-
through rate for non-rich media ads.
	 The industry is moving fast to replace 
static Web images and table-based 
designs with more sophisticated CSS-
based layouts complete with interactive 
video, multi-user communication applica-
tions like blogs and chats, and real-time 
RSS feeds. Companies like MINI USA, 
Penske Trucking, and Scripps Network’s 
HGTVPro.com are getting measurable 
results like increased Web traffic, brand 
awareness, and revenue by evolving their 
sites to support rich media design and 
development. 
	 MINI USA, a division of BMW of North 
America LLC, decided to reintroduce the 
MINI line of passenger cars to the U.S. 
market after a 35-year absence and drive 
interested shoppers to its network of 80 
dealers nationwide through an ambitious 

Web application. MINI USA faced a three-
fold challenge. It needed to create a new 
automotive segment (MINI is the small-
est car on the American roads), launch a 
new brand, and introduce two models 
simultaneously. As the team approached 
the design, the considerations were: how 
to leverage MINI’s rich heritage; how to 
express the BMW Group’s state-of-the art 
engineering; how to differentiate MINI’s 
motoring fun and exhilaration; and how 
to promote the brand’s unique selling 
proposition of customization and person-
alization.
	 Partnering with BEAM Interactive 
and using Macromedia Flash, MINI USA 
brought the brand to life online. It created 
a highly interactive Internet application 
on  HYPERLINK “http://www.miniusa.com” 
www.MINIusa.com that resonates with the 
self-expressive nature of MINI prospects. 
The heart of the site is the configurator, 
which lets people customize their own 
personal MINI through a simple, non-lin-
ear, five-step process that includes adding 
after-market accessories such as custom 
graphics and wheels. The navigation guar-
antees that absolutely everything is view-
able on one page at all times. Users can 
see the exact car that they are custom-
izing and can better understand the price 
implications of their configuration choices 
at each step in the process. The site’s rules-
based architecture ensures that users 
can actually buy the car they configured, 
despite the million design possibilities. 
MINI easily maintains the rules, although 
vehicle specifications change from year to 
year. When users have finished configur-
ing a car, they can name it, save it, calcu-
late the payments, and send their con-
figuration to a MINI dealer where it can be 
purchased. They can also download and 
print a fully customized color brochure of 
their creation. 
	 The site provides a seamless user 
experience with the dealer network 
and dealer sites, providing a sustainable 
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Maybe Not, but Rich Media Strategies Pay Off
by teresa ragan
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stream of highly qualified leads, while at 
the same time remaining consistent with 
other off-line branding efforts. 
	 What was the pay off? MINI USA 
exceeded its lead generation by 52% the 
first year, and 79% of all the leads were 
generated online. Of all the visitors, 73% 
of the registrants configured a MINI and 
the conversion into sales averaged 30%. 
MINI USA exceeded its sales goal by an 
incredible 25%, increased brand loyalty, 
and continues to give interested pros-
pects a unique shopping experience com-
pared to traditional carmaker sites. 
	 Would you like to save $220,000 in 
development costs? The team at Penske 
Truck Leasing Company did when it 
replaced the company’s enterprise 
content management system with a 
new advanced one. Penske has grown 
tremendously over the past 36 years. It 
started as a small truck leasing firm in 
Pennsylvania to becoming the number 
one truck rental and leasing company 
in the world. Its growth strained the 
enterprise content management system 
that managed the critical data assets that 
drive the company’s daily operations. The 
system wasn’t exactly small: it contained 
over 13,000 HTML files, 18,000 Microsoft 
Office files, PDF and image files and 2,000 
other kinds of files. The PENSKE team 
leveraged Macromedia Dreamweaver 
and Contribute to design, develop, and 
maintain the new content management 
system. 
	 At the end of the project, the team 
had saved over $220,000 in development 
costs. A team of 50 Web editors used 
Contribute, the template-based content 
management software that integrates 
with Dreamweaver, to quickly create and 
edit Web sites in a tenth the time of the 
old system. The cost-savings, streamlined 
maintenance process, and overall success 
of migrating an enterprise-critical system 
proved to Penske that its strategy was 
worth the effort. 
	 How are broadcasters better monetiz-
ing their ad services across TV and the 
Web? Scripps Networks Home & Garden 
offers advertisers a comprehensive, 
coordinated campaign that extends 
rich media assets as they target relevant 
audiences from on-screen to online. The 
Scripps Networks Home & Garden channel 
reaches nearly 80 million U.S. households 
on cable television. Its online property, 

HGTVPro.com, attracts nearly two mil-
lion unique visitors a month on average. 
The challenge was to drive traffic from 
its cable TV channel to the Web site and 
vice versa to leverage advertising oppor-
tunities as well as expand the network’s 
fast-growing brand as “America’s leading 
online home and garden destination.” 
HGTVPro.com’s best practices video 
site,  HYPERLINK “http://www.hgtvpro.
com/hpro/best_practices” www.hgtvpro.
com/hpro/best_practices, offers valuable 
on-demand home repair how-to’s previ-
ously broadcast only on cable, so its dual-
medium presence expanded its audience.
	 HGTVPro.com’s strategy to increase 
ad revenue was backed by designing and 
developing an integrated platform for 
delivering coordinated advertising units 
(video, static, and banner ads) with useful 
home how-to video programs, giving the 
advertiser greater reach. 
	 According to Tim O’Hare, a Scripps 
Networks Flash developer, “One of our 
main challenges was to offer an informa-
tive video application with extended 
content links, all within a limited space.” 
Beyond providing smooth navigation 
of a content-rich site, Flash’s ability to 
synchronize separate page elements was 
important. “We were able to tie our adver-
tisements to one another so that the ad 
unit within the best practices framework 
could be synchronized with the video ad 
as well as the leader board ad at the top of 
the page.” 
	 Flash let HGTVPro.com animate and 
synchronize its video content to best suit 
its users, meet its editorial needs, and 
deliver unobtrusive, targeted advertising 
to its growing audience. HGTVPro.com 
hit its advertising revenue objectives, and 
met the demands of its advertising clients 
through a rich-media delivery platform.
	 While our industry may not have an 
illustrious recognition platforms like the 
Nobel Prize or the Academy Awards, com-
panies like MINI USA, Penske, and Scripps 
Networks deserve credit for executing 
rich-media strategies and making them 
pay off with tangible results. Overall, rich-
media offers a great payoff for everyone: 
the customer experiences rich clean Web 
sites, the company achieves critical busi-
ness objectives, and designers and devel-
opers advance their knowledge base by 
working with the new tools and technol-
ogy now arriving in the market.

“Companies 
that emphasize 

customer 
experience as 

a strategic 
objective 

enjoy up to 
60% higher 

profitability 
and are twice 

as likely to 
exceed analyst 

expectations”
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on’t forget that you can blog 
yourself now, too, under the 
MXDJ domain – just follow 
the blog-n-play link from 

http://mxdj.sys-con.com.

Blog Topic: CFEclipse
Macromedia and Open Source 

– CFEclipse Announcement

By Rob Brooks-Bilson

www.dansshorts.com

	 From the CFUNITED conference in 
Bethesda, MD... 
	 “Macromedia announced formal 
support for the CFEclipse project ( 
HYPERLINK “http://www.cfeclipse.org/” 
http://www.cfeclipse.org/), pledging 
engineering support and collaboration 
for the project. CFEclipse will remain an 
independant project, with Macromedia 
providing advice, research, and code as 
time unfolds. 
	 Simeon Bateman, the project leader 
for CFEclipse also addressed the crowd 
stating that we should start to expect 
more regular builds as the collaboration 
with Macromedia moves forward. 
	 Expect the CFEclipse 2.0 release 
sometime this fall.” 

Blog Topic: Ruby on Rails

Why Rails?

By Michael Huffington

http://www.michaelbuffington.com/

	 “A couple people have commented 
and emailed me, asking “So, how’d you 
go from ColdFusion to Ruby on Rails? Can 
you talk about that some more, maybe 
give some tips?”
	 So, without delay and from my own 
personal perspective - my reasons for 
taking the plunge with some tips for 
newcomers as well. It’s verbose, and isn’t 
comprehensive, but it’s a start. I’d rather 
share now, and then share more later, 
than simply wait for later.
	 First, a little perspective - I’ve been 
writing ColdFusion applications everyday 

for nearly 10 years. I consider myself an 
expert, and even wrote a book with a 
major publisher a while back. For the past 
few months, I haven’t been able to bring 
myself to write any ColdFusion code. 
Ruby has dominated my coding efforts, 
and while I can’t say too much bad about 
ColdFusion, I have to admit that Ruby on 
Rails blows ColdFusion out of the water 
when it comes to productivity.
	 Here’s what I get by choosing Ruby on 
Rails over ColdFusion - after this, my story 
will become language agnostic (except 
when I’m talking about Ruby).

Tight MVC Framework

	 ColdFusion has some frameworks 
that aren’t bad. I’ve used Fusebox 3 and 
4, and Mach-II, and have even built my 
own MVC frameworks over the years that 
help me write code quickly. It’s pretty 
difficult to say that a good framework 
is a bad thing. But the frameworks that 
ColdFusion does have pale in compari-
son to the structure and tightness of the 
Rails framework. It’s hard to give specific 
examples without getting overly verbose, 
but even if all things were equal, tight-
ness-wise, the fact that just by typing rails 
my_app and having it build out the entire 
directory structure and build empty files 
for my application saves me some serious 
time. 

Generators

	 If I have my database built, I can build 
an entire web based application within 
five minutes. Three if I can type quicker. 
Being able to very rapidly generate CRUD 
views and controllers is super special, 
and nothing matches it anywhere else 
right now. Before Rails came along, I was 
building something similar to this - code 
generation based on code introspection, 
but compared to how Rails does it it was 
primitive, at best. 

Clean Code

	 You can write some pretty clean 

ColdFusion code, and it’s not even that 
hard to do, but Ruby is very clean. If I 
wanted to setup a loop that repeated 
some code, say, 10 times, in ColdFusion 
code, it would look like this: 

1

2

3�<cfloop from=”1” to=”10” index=”i”>

...

</cfloop>

In Ruby, it can be as simple as:

1

2

3�10.times do

...

end

These kinds of comparisons could be 

made all over the place. Ruby is sim-

ply much cleaner, and most often, very 

intuitive and natural looking. Rails 

continues this simplicity by having 

things like this:

1

2

3

4

5

6�45.minutes.from_now

@blog = Blog.find(:all)

@blog.posts.each do |post|

	puts post.author.name

	puts post.body

end

	 While these are trivial looking 
examples, looping over a “blog” object, as 
shown above, happen all the time in Rails. 
One of ColdFusion’s most important char-
acteristics is how it can make database 
records very easy to retrieve and use. 
Rails makes it easier (if you can imagine). 
In fact, behind the above example, Rails is 
doing SQL code that joins the Blogs table 
to the Posts table in our database, and 
does so because of some relationships 
that have been setup in our Blog model, 
and because I’m asking it to loop over 
blog posts. Very little code for a lot of 

The MX Blogosphere

Our regular feature taking an online stroll around the MX world 
by mxdj news desk

d

blog
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power - it’s what made ColdFusion entic-
ing to begin with and makes Rails even 
more so.

Open Source Software

	 Open source might not be your thing 
and that’s fine. It hasn’t always been my 
thing either. In fact, there was a time 
when I was deep into ColdFusion devel-
opment that I was happy that the com-
pany behind it, Allaire, didn’t release it as 
OSS. I saw OSS projects flare up, and fail, 
and flare up, and fail again, and I liked the 
stability that Allaire brought the table. 
	 That’s changed for me now, and Ruby 
on Rails is a perfect example of how an 
open source project can thrive. If you 
find a bug in Rails and you’re proficient 
enough in Ruby to fix it, you can make 
that bug fix happen. You won’t get paid 
for it in dollars, but you also won’t spend 
years waiting for a corporation to decide 
that the bug is worthy of fixing. Have 
you ever been plagued with CFHTTP 
issues with ColdFusion? It took years for 
Allaire/Macromedia to address some of 
the issues crippling CFHTTP. With Rails, 
a problem on that scale would likely be 
fixed in a day - no joke. There are enough 
eyes on the code, and enough people 
who care about having that code be 
good, that bad things are fixed quickly. In 
my meager several months of developing 
Rails apps, I’ve seen issues get fixed in 
surprising rapidity. That rapidity is usually 
a very good thing. Any problems it causes 
aren’t nearly as bad as having to develop 
elaborate workarounds to problems in 
ColdFusion that will likely remain in your 
application’s code for years.
	 Not only is Rails open source, it’s free 
to download, and you don’t have to pay 
a dime to anyone to develop and make 
money from Rails. This is encouraging to 
me, because the kinds of projects I like 
working on lately embrace free technol-
ogy. ColdFusion seems to do well in a 
corporate environment where the corpo-
rations can afford it. They get a company 
with a good track record backing the 
product, they get support, and they get 
well established training programs and 
materials to boot. With a new OSS project 
like Rails, you don’t get all of these things, 
though I probably won’t be able to say 
that in a few years.

Thriving Community

	 The Ruby on Rails community is sim-
ply on fire right now. There’s no doubt 
that the product evangelism is high - I’m 
contributing to it right now, but that’s 
because it’s a good product. For such 
a new product (a little over a year old) 
the community supporting it, in relative 
terms, is massive. I’ve watched communi-
ties of other products before, and have 
never seen as much growth. A rapidly 
growing community of evangelists means 
that the product will come under even 
more scrutiny, and out of that scrutiny 
there will emerge better ways of doing 
things. 
	 Economically speaking, it’s a good 
thing to have a lot of people saying 
good things about a web application 
framework. The things that people are 
saying about Rails help build the support 
- the appeal of rapid development, easy 
changes to existing applications, and 
tight controls over the framework appeal 
to people willing to pay for Rails develop-
ment. This is a good thing for both the 
developer and those paying developers.
	 None of this suggests that the 
ColdFusion community is bad - but I’m 
not sure I can say it’s thriving. Perhaps 
it’s not a fair comparison, but go into the 
Ruby on Rails IRC channel (#rubyonrails 
on FreeNode) and you’ll typically find 
200+ people talking about their Rails 
problems and helping others with theirs. 
On the #coldfusion channel, you’ll usually 
only see a handful, or 20ish at best.
	 Of course, this thriving community 
could fizzle, but I’m betting it won’t. 
While I’m sure it’s happening, the major-
ity of people participating aren’t doing 
so just because of the recent media buzz 
around Rails. They’re doing so because of 
the product, and they believe it’s a good 
thing to help others get into it.”

Blog Topic: Dreamweaver 8
Dreamweaver 8 - XSLT Authoring

By Scott Fegette

http://weblogs.macromedia.com/sfegette/

	 “Syndication is one of the most rapid-
ly-growing themes online these days, and 
I’ve personally used RSS and Atom feeds 
to browse and aggregate content from 
the blogosphere, news sites, podcast 
directories, TV listings and many other 
sources quickly and easily in Flash (using 
its XML features) as well as with some 
server-side tricks. And now with version 

8, Dreamweaver speaks XSLT author-
ing- allowing you to really do something 
with all those XML documents and site 
feeds you’ve been collecting. Roll up your 
sleeves, this FOTD will be a doozy (and it’s 
relatively certain I’m only going to scratch 
the tip of this iceberg).
	 An XSL document can be an entire 
document, or just an XSL ‘fragment’ that’s 
included/embedded in an existing HTML 
page. If you look at XML (and it’s deriva-
tive content types, such as RSS, RDF and 
Atom syndication feeds) as strictly your 
content, and XSLT as strictly your presen-
tation, you’ve got the rote basics. Now 
let’s say you want to provide users on 
your site with a listing of the most recent 
posts and FOTDs I’ve written here. Let’s 
start by creating a new XSLT document 
(entire page) by choosing “File < New...”, 
and noting the two new XSLT document 
types in the template list:

	INCLUDEPICTURE “http://weblogs.mac-

romedia.com/sfegette/blogimg/studio8/

new_file_types.gif” \*

MERGEFORMATINET

  

	 The new XSLT document types- (XSLT 
- Entire Page & Fragment) 
	 As noted earlier, an XSLT document 
is a fully-formed document that you cre-
ate to display a particular XML schema, 
and an XSLT fragment is for small news 
pods, lists, etc. that are to be displayed 
in an existing HTML page. In this case we 
want to create an entire page listing the 
current entries from my weblog, as pub-
lished via its XML-based RSS 2.0 feed. 
Let’s dive in. After creating my new XSLT 
(entire page) document, I’m immediately 
asked to show Dreamweaver a sample 
document- either locally (on my com-
puter) or remotely via the network. I’ll use 
the URL for my RSS 2.0 feed here as the 
basis for this new page: http://weblogs.
macromedia.com/sfegette/index.xml

	INCLUDEPICTURE: “http://weblogs.

macromedia.com/sfegette/blogimg/stu-

dio8/locate_xml_source.jpg” \* 	

MERGEFORMATINET

Locate XML Source dialog 

	 After entering the URL and clicking 
‘OK’, you’ll note the ‘Bindings’ tab of the 
Application panel is now updated with 
the schema of my XML/RSS feed- much 
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like dynamic application development, 
this represents the heirarchical levels of 
data in my feed- both ‘global’ data vari-
ables that represent my ‘blog itself - its 
title, the link to it’s home page, descrip-
tion, copyright information, etc. - along 
with variables that are different for each 
content ‘item’ in my ‘blog, such as title, 
description, permalink, category, etc. The 
top-level container is ‘RSS’- the actual 
schema used in my RSS 2 file. 
	 Wanna see?

	INCLUDEPICTURE “http://weblogs.

macromedia.com/sfegette/blogimg/stu-

dio8/xml_bindings_panel.jpg” \* 

MERGEFORMATINET 

My RSS file’s schema

	 From here, let’s do a quick test. I sim-
ply drag the channel ‘title and ‘lastBuild-
Date’ into a sentence I’ve already typed 
into Dreamweaver’s design view as so:

 INCLUDEPICTURE “http://weblogs.

macromedia.com/sfegette/blogimg/stu-

dio8/global_vars_before.jpg” \* 

MERGEFORMATINET 

... and when previewing in my browser, 

it becomes...

 INCLUDEPICTURE “http://weblogs.

macromedia.com/sfegette/blogimg/

studio8/global_vars_after.gif” \* 

MERGEFORMATINET 

Nice and easy! 

	 I’ve just dynamically updated the 
content in that page based on the ‘blog 
description and last update time in my 
live RSS feed. Are the potentials here 
becoming obvious yet? If not, let’s take it 
a step further. 
	 We just updated the page itself with 
the singular title and ‘last modified’ date 
from my ‘blog, but what about variables 
in my XML schema that repeat- i.e. the 
variables underneath the ‘item’ node, 
which represent data in the posts them-
selves? Well, they’re handled much 
like repeating regions in your favorite 
Dreamweaver server models- you need 
to set up an area that repeats, and then 
populate it with the dynamic data. First, 
I’m going to create a table to hold the 
sequential ‘blog postings themselves- but 

just build out one entry as a ‘mockup’ 
like so (table borders left in place to help 
clarify):
 
INCLUDEPICTURE “http://weblogs.

macromedia.com/sfegette/blogimg/

studio8/item_vars_before.gif” \* 

MERGEFORMATINET 

Starting ‘dynamic’ XSL view 

	 Now I’m assuming that these three 
table rows will repeat for each ‘blog post 
(item) in my RSS feed, so we need to tell 
Dreamweaver what part of the page actu-
ally repeats so it can do the heavy lifting! 
Since the three consecutive table rows 
will repeat, I’ll just drop into Code View, 
select all three <tr> rows, and then select 
the menu option “Insert < XSLT Objects 
< Repeat Region”, which brings up the 
XPath Expression Builder (although I 
won’t get into it in this FOTD, XPath is 
how you write expressions to condition-
ally interact with your XML data, very 
powerful):
 
INCLUDEPICTURE “http://weblogs.mac-

romedia.com/sfegette/blogimg/studio8/

repeat_region.gif” \* MERGEFORMATINET 

Selecting the table rows to loop, and 

then... 

INCLUDEPICTURE “http://weblogs.mac-

romedia.com/sfegette/blogimg/studio8/

xpath_xbuilder.jpg” \* MERGEFORMATINET 

	 Binding them to the ‘Item’ node for 
looping
	 This will simply tell Dreamweaver to 
write those three rows for each ‘item’ in 
our RSS file, using specific values from 
each post to do so. We just did the first 
part (set up the repeating 3-row region), 
now let’s finish the job by dragging the 
appropriate variables (title, description, 
link, date) from our Bindings Panel into 
the comp we’ve created replacing our 
‘boilerplate’ text- and hit Preview in 
Browser to see it in it’s full glory:
 
INCLUDEPICTURE “http://weblogs.mac-

romedia.com/sfegette/blogimg/studio8/

final.jpg” \* MERGEFORMATINET 

The final XSL page 

	 And that’s all there is to it- with 
Dreamweaver 8 you can quickly consume 
XML data, bind it to areas of your docu-
ment, and display it dynamically on your 
site. A few points to note:
This FOTD does not cover server-side 
transformations, which are possible as 
well w/DW 8, but require your server to 
be configured with XSLT support. 
	 Despite the above, Dreamweaver will 
still let you perform client-side XSLT trans-
formations using an included Javascript 
file (DW 8 will provide it, no worries) that 
you simply upload to your web server 
alongside your XSL document/fragment. 
	 Although we just showed a very basic 
example here, with the power of XPath 
you can build very complex logic around 
your XML datasources, allowing very 
involved applications without a tradi-
tional ‘server model’! 
	 Anyway, as mentioned in the first 
paragraph, I’m barely scratching the sur-
face of what you can do with XML and 
XSL in Dreamweaver 8- but the possibili-
ties are endless. Don’t forget you can also 
consume XML data in Flash 8 (but that’s 
not necessarily news), too.

Blog Topic: ColdFusion

ColdFusion Powered Site Helping 

Katrina Victims

By Ben Forta

from  http://www.forta.com/blog/

	 “KatrinaLost.org ( www.KatrinaLost.
org) hosts an online database of 
Hurricane Katrina victims (both lost and 
found), and an extensive housing data-
base for victims to find nearby shelter 
and accommodations. 
	 After Labor Day, KatrinaLost.org will 
unveil a comprehensive database of jobs 
for displaced workers. The ColdFusion MX 7 
powered site was built by Javier Julio (who 
helped out at CFUNITED this year) and Jason 
Fill, and is hosted by E101 Linux Systems.”

Blog Topic: Studio 8
Macromedia – Studio 8

By Kevin Airgid

from http://blog.airgid.com/

	  “Macromedia Studio 8 launched by 
Macromedia. Seems worth the upgrade 
to me.”
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	 In each case what we sought to do 
was, first, establish which technologies 
our respondents used most frequently (in 
order of most regular use) – so that read-
ers can factor that in when considering 
their replies.
	 Topics dealt with ranged from the 
gamut of Macromedia’s various technolo-
gies to wider issues such as future road-
maps, parallel technologies, competing 
technologies, and of course the upcom-
ing Adobe-Macromedia deal, if it goes 
ahead this Fall.
	 At MXDJ we like nothing more than 
to let the community speak for itself, so 
without further ado, let’s get into the 
answers of our sampling of movers and 
shakers in the industry. We make no claim 
to be scientific: but these are the raw 
insights of real-live technology profes-
sionals, just like you, and we are extreme-
ly proud to bring them in this very special 
issue of the magazine.  
	 To all those who participated, our 
thanks. It is thoughtful writing like these 
responses that makes MXDJ what it is.

Name: Jesse Randall 
Warden
Position: Senior Macromedia Flash 

Developer working full-time at Round 

Box Media (http://www.roundbox-

media.com).

Technologies used: Flash Player 7, 

Flash MX 2004 Professional, Flex & 

FlexBuilder, and Fireworks

“Macromedia's main contribution is the 
immense install base for the Flash Player as 
well as its correctly perceived security.  For 
the developer, an ECMA standards based 
language that can evolve fast (compared 
to JavaScript), a ubiquitous platform, 
and ability to interface with a multitude 
of services (Text, XML, SOAP/RPC, Sockets 
[ASCII & Binary], and Remoting).  For the 
designer, the ability to create and display 
whatever they come up with, to have it 
look like intended on all platforms, and 
the opportunity to work with developers to 
make applications rich.  For business, the 
ability to get quicker to market solutions for 
the front-end that give an edge in looking 
better than competitors.  For the user, the 
ability to give better experiences garnered 
from the benefits outlined above.”

Q. In the last ten years what non-

Macromedia technologies (if any!!) have 
you envied?
A. Microsoft’s Visual Studio, Borland’s 
Delphi, Adobe’s AfterEffects, Alias’ 
Maya, Sony’s SoundForge & ACID, and 
Propellarheads’ Reason

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. Bringing Flex development to the 
masses via an appropriately priced point 
and/or a hosting license; improving the 
Flex workflow thus allowing qualified 
designers to create the next generation 
of Rich Internet Applications; bringing 
ActionScript 2.0 to mobile devices via 
Deuce (Flash Lite 2.0); and finding a 
way to get a product ahead of its time, 
Central, back into the market again.

Name: David Sawyer 
McFarland
Position: President of Sawyer 

McFarland Media Inc. (http://www.

sawmac.com), a web development 

and training company located in 

Portland, Oregon.

Technologies used: Dreamweaver MX 

2004, Fireworks MX 2004

“Macromedia has really coined the term 
“Rich Internet Application.”  The evolution 
of Flash from animated banner-ad creator 
to sophisticated online application develop-
ment environment has made companies 
(and most people who use the web, for that 
matter) see that the Web can and should 
be more than just a hop-scotch game of 
hyperlinks.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. I don’t know about envy, but I’d say 
I admire the way many open- source 
technologies have changed the playing 
field for Web design and development. 
The open source software movement has 
made a huge impact on the current state 
of the Web: from powerful, enterprise-
level servers like Apache and MySQL, 
to the vast array of free (as in beer and 
in speech) software aimed at deploy-
ing a range of Web applications such 
as Blogs (Wordpress – www.wordpress.

org), bulletin boards (PHP Bulletin Board 
– www.phpbb.com), and countless other 
content management systems (www.
opensourcecms.com). By all accounts, the 
future of the Web will be peppered with 
even more open source technologies; or 
at least, many corporations will give up 
proprietary standards in favor of open 
standards. Microsoft’s announcement 
that they’ll adopt XML as the standard 
file format for the next versions of Word, 
Excel and PowerPoint is probably just 
the beginning of a greater convergence 
of technologies that promote the easy 
exchange of information.

Q. What new areas are you looking 
forward to Macromedia’s team heading 
off into?
A. Well, my bias is toward the good old 
HTM of L. While I’m in awe of the rich 
internet experience Flash is capable of, I 
hope that Adobe-Macromedia takes the 
lead in developing tools to support the 
fresh resurgence of DHTML, and in par-
ticular the use of what’s become known 
as Asynchronous JavaScript and XML, or 
AJAX for short. 

Q. And what about the technology 
future in general?
A new generation of rich internet applica-
tions that use HTML,  JavaScript, CSS and 
server-produced XML are promising to 
deliver  Web applications that feel like 
applications. Google leads the charge 
with tools like Google Suggest (www.
google.com/webhp?complete=1&hl=en) 
and Google Maps (http://maps.google.
com). But, every day, someone new 
debuts a DHTML and AJAX-enabled 
application with jaw-dropping effects 
that make you scratch your head and 
say, “No, that’s got to be Flash!” Like the 
simple and intuitive list management 
web app, Ta-da Lists (www.tadalist.com), 
or the sublimely creative drag-and-drop 
shopping cart from Panic software (www.
panic.com/goods), or the “hey ain’t that 
Adobe Acrobat” world-wide news paper 
reader Press Display (www.pressdisplay.
com) – and yes, that last one really is 
HTML!

Name: Jim Babbage
Position: Teacher of imaging, 

Web design, and photography at 

Centennial College’s Centre for 
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Creative Communications (www.

thecentre.centennialcollege.ca) and 

partner in Newmedia Services (www.

nms123.ca), a small communications 

company.

Technologies used: Fireworks, 

Dreamweaver and Captivate 

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. An even more robust, feature rich 
Fireworks application, that merges the 
bitmap strengths of Photoshop (notice 
I did not say ImageReady) with the 
workflow and live editing capabilities 
of Fireworks and the vector power of 
FreeHand.  Not asking for much, am I? 
With Dreamweaver, even more standards 
compliance and CSS rendering support.
 
Name:  Tom Muck
Position: Senior Applications 

Developer for Integram in Northern 

Virginia and coauthor of three 

UltraDev books including the best-

seller, Dreamweaver UltraDev4: The 

Complete Reference. 

Technologies used: ColdFusion MX as a 

server technology, Dreamweaver MX as 

a tool, and Flash Remoting MX in some 

applications.

“The ColdFusion platform is amazing for 
ease of use, and also scales very well to an 
enterprise level. Experienced Java program-
mers can make use of Java to get down into 
the nitty-gritty, but the core functionality of 
an application can be built quickly in CFML. 
Enterprise-level applications can be deliv-
ered much more quickly using ColdFusion 
than any other technology.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. I have always wished that Macromedia 
had put a debugger on the ColdFusion back 
end, as well as on the Dreamweaver front 
end, to assist in coding. Other technolo-
gies like PHP and ASP.NET have excellent 
step debuggers that speed up coding. 
Macromedia has not pushed to get debug-
gers into their tools or servers. The debugger 
in PHPed is great, and just what Macromedia 
needs for its ColdFusion language.

Q. And the future – if the merger goes 
ahead?
A. I would hope that Adobe/Macromedia 
would continue on a similar path, but 
maybe with some more resources and 
more muscle. For example, Dreamweaver 
is the best web tool around, but is still 
lacking a lot in key areas, such as debug-
ging capabilities, performance, stability, 
and team development. I’d love to see 
Adobe/Macromedia put the same effort 
into web tools that Microsoft puts into 
their Visual Studio. 

Name: Erik Bianchi
Position: Software engineer with 

more than five years of experience 

developing Flash-based RIAs and 

enterprise-wide applications for 

Fortune 50 and 500 companies 

(www.erikbianchi.com).

Technologies used: Flash MX Professional 

2004 and I play around with Flex.

“What Macromedia has done better than 
most other companies is a) its community 
relations – really supporting the Flash com-
munity with various blogs, newsgroups, 
user groups, conferences, developer centers 
(devnet) articles, online presentations, and 
trial versions of software.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. Outside of the Macromedia sandbox I 
do have my eye on Xamlon Web, which 
allows you to develop Flash applications 
using XAML and C# in .NET which is very 
appealing to me on multiple levels. 1) it 
gets me out of the Flash IDE and using 
.NET and 2) I imagine that this would 
make Flash development much more 
approachable to .NET and other develop-
ers.

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. Macromedia’s Flash has certainly 
upped the ante in how applications UIs 
are perceived. Because what we are deal-
ing with are web applications that run 
across multiple OSs and served from a 
remote location, we don’t have to worry 
about actually installing anything on the 
client's machine or compatibility issues. 

This I think gives us some creative free-
doms that other developers don’t enjoy 
for typical shrink wrapped products.
	 In a way I see Flash developers as pio-
neers as they are more easily able to mix 
creative expressions with technology. You 
want to add an experimental UI to your 
application you can do it. If it doesn’t 
work you can easily (in a well architected 
application) pull it out for something 
more traditional and only have to worry 
about changing the swf on the server. 
However it’s rather unfortunate that 
dynamic runtime share libraries are not 
well supported.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. The faster rendering capabilities that are 
provided by bitmap caching and the new 
player filters seem amazing in the next 
Flash Player! Also, I think we (as Flash devel-
opers) have a lot to look forward to with 
the repositioning of Flash as a development 
platform. I’ve been referring to Flash as my 
development platform now for years but 
with Macromedia’s backing I think that it 
adds a bit more validity to my statement 
and that it says a lot about where Flash is 
going and how it is going to be perceived 
by other non-Flash developers.

Name: Dennis Baldwin
Position: Software developer for 

SensorLogic Inc – runs and main-

tains an online community for Flash 

and ColdFusion developers (www.

devmx.com).

Technologies used: Flex, Flash MX Pro, 

ColdFusion MX, Dreamweaver MX

“The future is bright for application devel-
opers because we’ll be able to leverage the 
Flash platform to deliver robust applica-
tions in a fraction of the time.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied? 
A. Adobe Photoshop; Adobe Illustrator

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
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A. When Macromedia embraced the fact 
that Flash was much more than an anima-
tion tool and started positioning it as a 
platform to build truly engaging RIAs. In my 
mind, products like Flash Remoting and the 
ActionScript components for Flash (both V1 
and V2) were essential to the adoption of 
Flash for enterprise development. 

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)? 
A. I’m extremely excited about the poten-
tial of the Flash Lite player and what it 
offers for mobile devices. I’m a huge fan 
of the Symbian OS and the announce-
ment by Nokia to support Flash Lite on 
all their Series 60 devices is huge.  I think 
we’ll start to see more enterprise-level 
applications on devices.
	 The other much hyped area is Flash/
PDF integration. I can envision opening a 
PDF file and watch an animated tutorial 
within the document.....no skip intro but-
tons please!

Name: Kim Cavanaugh
Position: Teacher and writer 

about web design software from 

Macromedia for over 5 years 

and has written two books about 

Dreamweaver and Fireworks, 

collaborated on books about 

Dreamweaver, Fireworks, Flash and 

Contribute, and continues to write 

extensively about Studio MX tools for 

CommunityMX.com.

	 Technologies used: “Depending on 

where I am in a particular project I might 

be prototyping and designing in Fireworks, 

working up banners or adding video in 

Flash, or creating a site and maintaining it 

in Dreamweaver. Suffice it to say that no 

matter what I’m doing – from site design 

to eLearning development to delivery of 

content – Macromedia tools are my tools 

of choice. That includes all of the Studio 

tools as well as Breeze and Captivate.”

 “The Flash Player has changed the face of 
the Web. Regardless of how the content is 
developed – Flex, Flash, Breeze, Captivate 
– it all comes down to the Flash Player and 
its ubiquitous spread across the Web. I think 
you’d be hard-pressed to find any single 
application that does so much for so many, 

works consistently, and provides so many 
avenues for delivering (trite as it may be to 
say it) a rich user experience.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. I suppose I wish there were a richer 
toolset for bitmap editing like you get 
with Photoshop, but without the steep 
learning curve. While I love Fireworks 
dearly and couldn’t work without it, the 
depth of colors and the rich images you 
can create in Photoshop are something 
that Fireworks has trouble approaching.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. Devices of course will be huge as the 
infrastructure for delivering networked 
content to PDAs and cells and handhelds 
and TVs and the myriad other products 
out there that can take advantage of 
streaming content are introduced. In 
terms of the merger, well, to be honest 
I’m afraid I think that’s all about share-
holder value and has little to do with 
improving tools for web content delivery. 
I’m sure there will be some new tools 
developed as a result of the merger, just 
to remain competitive, but I honestly 
don’t see a large corporation such as 
Adobe breaking new ground and being 
as nimble as Macromedia. Mark me high-
ly skeptical on the value of the merger to 
me and to the Web at large.

Name: Darron J. Schall
Position: An application developer 

interested in all things programming, 

from ActionScript to XML and every-

thing in between – maintains a Flash-

related weblog (www.darronschall.

com).

Technologies used: “Flash and ColdFusion 

have been my technologies of choice for 

a long time, but lately I’ve jumped on the 

Flex bandwagon.  Flex has been dominat-

ing my time, especially in the past month, 

and I see myself moving exclusivly to Flex 

for my RIA development.”

“Flash isn’t just ‘those annoying banner ads’ 
anymore, but rather a viable platform to 
deliver a client side solution for.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. Being a developer, I’ve always envied 
the .NET and Java development  envi-
ronments and the tools associated with 
them. There’s a certain level of matu-
rity there that ActionScript hasn’t quite 
found yet. Visual Studio and Eclipse are 
a hundred times better than any IDE 
for ActionScript at the moment. Not to 
mention the supporting cast of tools 
for things like code generation from 
class diagrams, round-trip engineering, 
Model Driven Archtecture, etc. Pile on 
the extensive library support and Java 
and .NET look really tempting, but .swf 
still dominates the internet landscape... I 
believe the sophistication of ActionScript 
will continue to improve over time, so I’m 
not that jealous.

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. Flex. Flex opened the door to the 
Flash Player to enterprise level Java 
developers. Finally the Flash Player is 
being recognized in the enterprise mar-
ket, and we’re all benefiting because 
of it.  

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. I’m looking forward better tools and 
the maturation of the Platform overall. 
The announcement of Zorn being built 
on Eclipse has me extremely excited. The 
current Flash Player is already solid, and 
it’s clear that Macromedia is committed 
to its customers based on the features 
present in Maelstrom. I’d like to see more 
work done for Flash-on-the-desktop 
though – imagine a cross platform desk-
top solution authored in Flash? I think 
that would be amazing.  It’s exciting to 
think about where the Flash Platform will 
be 5 years down the road.

Name: Sam Coles
Position: Flash designer

Technologies used: Flash and ActionScript 

2 on a daily basis, and Dreamweaver in 

conjunction with Flash for page layout.
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	 The Flash Platform has allowed busi-
nesses to quickly build dynamic and engag-
ing websites and RIAs without sacrificing 
aesthetics or functionality.  Macromedia’s 
Technologies fill a niche in the market that, 
in my opinion, nothing else comes any-
where close to achieving.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied? 
A. There are a few emerging technologies 
out there, especially proce55ing, that 
have really caught my eye lately.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)? 
A. I really love, no I’m infatuated with, 
the new video features in the next itera-
tion of Flash. I think in the next couple 
of years Flash will become an increas-
ingly viable option for video streaming 
and playback. It’s just starting to take 
off right now but I see it becoming a, if 
not the, leading technology for video 
playback on the web in the near future. I 
hope Macromedia pursues this area more 
because other streaming media options 
out there are rather limited and not the 
lightest weight.  I would also like to see 
easier multiuser development. Having 
some type of versioning that works well 
with Flash would be a feature I’m sure 
many developers would greatly appreci-
ate.

Name: Justin Kozuch
Position: Witer, web developer, 

and Team Macromedia member 

who takes pride in helping other 

Macromedia Dreamweaver users.

Technologies used: Dreamweaver MX 

2004, Fireworks MX 2004, ColdFusion 

MX 7.0

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. Photoshop. Fireworks has so much 
potential for improvement, it could very 
well give Photoshop a run for its money, 
but this potential lies within the contribu-
tions of the user community and how 
much Macromedia is willing to spend 
on R&D as far as improving Fireworks is 

concerned. Given the Macromedia-Adobe 
merger, I doubt that Fireworks has much 
of a future, which is rather unfortunate.

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. Coldfusion MX 7.0 has by far 
Macromedia’s greatest contribution. 
The ability to communicate with Mobile 
Devices, provide rich  experiences, and 
interact with the desktop by creating 
portable documents (PDF, FlashPaper) are 
just a few of the many aspects in which 
ColdFusion MX 7.0 excels. I am truly 
impressed with the ColdFusion MX 7.0 
handles tasks with ease and how easy it 
is to create enterprise level applications 
with less code than some of the other 
programming languages out there (ASP, 
.NET, JSP, PHP, etc). As far as inspiration 
goes, Flash is definitely the winner. The 
ubiquity of the Flash player is one reason 
why it has so much “sex appeal”. Creating 
rich experiences with Flash that can be 
viewed anywhere, anytime is the new 
Internet.

Q. Adobe-Macromedia?
A. I’d really like to see where Adobe takes 
the Flash Platform. That is definitely 
something I am interested in seeing, and 
how they progress with it.

Name: Matthew David
Position: Specialist in next-gen-

eration Web solutions and author 

of Flash Books (Flash MX Magic, 

Building Great Flash MX Games, 

Flash 3D Bible, and Flash MX 

Communication Server Bible). Writes 

300 articles a year for more than 20 

international magazines. 

Technologies used: Flash MX 2004 

Professional, Dreamweaver MX 2004 and 

Fireworks MX 2004. 

 “Flash is only at the start of it’s techno-
logical wave. I see work where Flash is tied 
tightly into Adobe’s product line (notably 
with Acrobat) and I also see where Flash is 
tied to application servers through technol-
ogies such as Flex and native Web services 
support.” 

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 

you envied? 
A. The work being done in the 3D world. 
I really feel that the time is right for Flash 
to engage and use true 3D as a core fea-
ture to the Flash Player. 

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration? 
A. For me, the best has to be the evolu-
tion of Flash from animation to applica-
tion software. This really allows me to 
build solutions that not only work, but 
buzz! 

Name: Stephanie Sullivan
Position: Stephanie Sullivan is a Web 

developer, partner at CommunityMX 

(www.communitymx.com), owner of 

VioletSky Design (www.violetsky.

net), and contributing author of 

Dreamweaver MX 2004 Magic.

Technologies used: “I use Dreamweaver 

about 16/6 (I have to sleep sometime); 

I use and receive Fireworks comps to 

create my sites with.;I work around 

ColdFusion with developers but don’t write 

it; I use Flash to create sIFR swf files and 

tweak components and Freehand for the 

occasional print job.”

“To me, one of the strong points of 
Macromedia as a company has been a) 
their involvement with, and reaction to, 
feedback of the community, and b) their 
vision for the future. I would like to see 
Adobe integrate and keep these attributes.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. I don’t envy anything really. I sup-
pose a good font or CSS program 
World have been useful to me. But with 
Dreamweaver’s recent CSS upgrades, 
that’s hardly necessary now. Basically, if I 
need it I buy it, whether it’s Macromedia 
or not. I just don’t require much outside 
the Studio suite.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. I’m honestly hoping to see Adobe head 
into more of a Macromedia direction.

9 • 2005 mxdj.com • 19



In my opinion, the open ears and minds 
of the Product Managers and Engineers 
at Macromedia during alpha and beta 
development cycles is unmatched and 
the value shouldn’t be underestimated. I 
hope this won’t be lost. No doubt there 
will continue to be forward-thinking, 
innovative developments happening on 
the Flash platform. But what I hope the 
merger will bring is increased exposure 
for Fireworks. Having more development 
money and marketing muscle behind this 
very worthy, but lesser known product, is 
what I’d most hope to see happen.

Name: Dan Short
Position: Runs a successful Web 

development company, Web 

Shorts Site Design, is also the Lead 

Developer for Cartweaver (www.

cartweaver.com), and helps maintain 

several HTML and Dreamweaver 

reference sites, including the 

Dreamweaver FAQ (www.dwfaq.

com). Coauthor of Dreamweaver 

MX Magic 2004, Dreamweaver MX 

Bible (Wiley), and Dreamweaver MX: 

Advanced ASP Web Development 

(Glasshaus).

Technologies used: ColdFusion MX

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. ColdFusion MX 7, easily. The ability to 
generate flash on the fly with simple CF 
tags is awesome.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. More improvements in CF, improved 
OO development practices, improved 
Flex integration – and hopefully lower 
pricing on that server).

Name: Jared Rypka-Hauer
Position: Management/Architect/

Developer

Technologies used: ColdFusionMX, 

DreamweaverMX, FireworksMX, and 

FlashMX.

“CFMX bridges between the HTTP/HTML 
world and the OO world that supports it.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. If there was any it was OO constructs. 
Macromedia has always been at the 
forefront of innovation when it comes to 
my interests. Mike Nimer, from the CFMX 
development team at Macromedia, and 
I had a chance to discuss ColdFusion 
MX’s place on the web at CFUnited and 
he made the point that CFMX bridges 
between the HTTP/HTML world and the 
OO world that supports it. It made so 
much sense, and describes where I feel 
most at home as a programmer. I like 
connecting separate things, making what 
once wouldn’t have worked together 
work well into whole system. ColdFusion 
fits that role perfectly.

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. Definitely the OO enabling of CF and 
ActionScript. We now have the ultimate 
integration platform! I think that Adobe’s 
involvement is a blessing for us on sev-
eral levels: Adobe can insure that funding 
for development and marketing will be 
available to a larger degree in the future. 
Adobe’s position in other markets can 
help insure friendly relationships with 
other vendors like Apple. Adobe’s existing 
product line contains several enterprise-
class products, which sell to enterprise-
class clients that can be leveraged to buy 
into the MX technology platform. Why do 
these things matter to me? That’s easy: 
Microsoft. Adobe should be a “safe har-
bor” that will help guarantee us a place to 
compete with Microsoft and .NET on their 
own turf.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. Specifically I look forward to enhance-
ments in those parts of  ColdFusion 
MX that generate content (like the 
paragraphFormat() function) and will 
allow us to create standards-compliant 
HTML (and CSS) more quickly. I also look 
forward to deeper integration between 
ColdFusionMX and Adobe’s complimen-
tary products (plus  Flex/FlashMX). I also 

hope that Adobe might be able to take a 
stronger look at  something Macromedia 
just never had the resources for – applica-
tions with an embedded CFMX engine 
and database that work well for either 
small companies via intranet or even as 
desktop applications. As our ability to 
generate rich interfaces gets better, we 
have a killer platform for massively inte-
grated desktop applications.

Name: Alexandru Costin
Position: President of Products 

Division at InterAKT Online and one 

of InterAKT’s product architects, also 

involved in maintaining the InterAKT 

suite of Dreamweaver productivity 

tools. 

Technologies used: “I use Dreamweaver 

the most, especially because the nature of 

my job Apart from the MX technologies, 

I use Captivate, a great tool for creating 

presentations that help you win bids and 

clients.”

“I work at InterAKT, and we do Dreamweaver 
extensions for a living). Looking back in 
the past, we’ve started with Ultradev 4 (by 
creating the first PHP support for Ultradev), 
then we’ve continued with Dreamweaver MX 
and MX 2004. We’re also looking forward to 
future Dreamweaver versions, lately we’ve 
been partnering with Macromedia to create 
the ColdFusion 7 support for Dreamweaver, 
and we hope that this will be included in the 
next version.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. Toyota Prius (and hybrid cars) – not 
a web technology, but definitely some-
thing to look into in the future; I’ve heard 
from Sean (Corfield) that he’s got one 
and I envy him. Second, the iPod – a non-
Macromedia technology recently trans-
formed almost into a religion. Regarding 
web development tools, Eclipse – with 
its CFEclipse branch – the single platform 
more extensible than Dreamweaver. 
Finally, AJAX – even if Macromedia did 
it long before the name was invented 
(Dreamweaver is a JavaScript application, 
CourseBuilder for e-learning was really 
neat on DHTML)

Q. When it comes to enterprise-class 
development, what do you consider 
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Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. Definitely ColdFusion – one of the first 
application servers, still kicking today by 
adapting to the “Java world” realities. In 
terms of Rich Internet applications, Flex 
(or should I call it Flash platform?) is prob-
ably the next big thing, by separating the 
presentation layer from the application 
logic.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. Redmond. Let’s eXperience some epic 
(technology) battles!!

Name: Jeff Tapper
Position: Chief Technologist for 

Tapper.net Consulting and a 

Macromedia Instructor, certified to 

teach all of Macromedia’s courses on 

ColdFusion and Flash development. 

Technologies used: Flex 1.5, Flash 2004 

MX Professional, and ColdFusion MX7.

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A.  This is a really difficult question to 
answer, as invariably, I envy any technol-
ogy which would make the tasks I need 
to do today easier, but which I dont 
have access to.   In the past, I’ve deeply 
envied things like XPath (now available in 
ColdFusion and Flash) for searching XML, 
prior to Flex I was very envious of Laszlo.  
At other times I envied JMS (which is 
now trivial to interact with from CFMX7, 
thanks to event gateways)

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. As a 10 year customer of Macromedia 
(and Allaire before them), I’ve always 
considered their main contribution 
to the technology  to be empowering 
developers to build better and better 
applications quickly and easily. 10 years 
ago I was amazed at how quickly  I could 
connect a web page to a database with 
CFML (actually, it was DBML at the time, 
but thats another story), 4 years ago with 
the introduction of Flash Remoting, I was 

amazed at how quickly and easily com-
pelling Flash UI’s could be connected to 
my ColdFusion server, and 2 years ago I 
was amazed at how much more 
quickly and easily I could build compel-
ling Flash UI’s with Flex.  Across all of 
these, the recurring theme is empower-
ing me as a developer to build better 
apps quicker.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. I look forward to seeing how the next 
generation of Macromedia tools will con-
tinue to let me build better apps more 
quickly.  I’m expecting the Adobe merger 
will at a minimum expand the ease and 
richness of MX apps for the web into easi-
er, richer printable pages from our apps.

Name: Simon Horwith
Position: Editor-in-chief of 

ColdFusion Developer’s Journal 

and CIO at AboutWeb, LLC, a 

Washington, DC based company 

specializing in staff augmentation, 

consulting, and training. Macromedia 

Certified Master Instructor and mem-

ber of Team Macromedia. 

Technologies used: “I use ColdFusion as 

the platform for most of my development, 

usually I use Dreamweaver to write the 

code (though I also use CFEclipse and 

HomeSite+).  When clients desire a rich 

internet application interface, I use Flash 

and/or Flex depending on their needs.”

“Flex is a terrific example of how an 
Enterprise Application server should be. 
Everything about the way you develop Flex 
applications has the enterprise in mind, as 
well as encouraging scalable, architectural 
(application design) best practices.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. Wow, that’s a good question. I’ve 
always envied the IDE (Visual Studio) 
that MS developers use – say what 
you want about Microsoft, they do 
make great development environ-
ments. I’ve also envied Java develop-
ers because of the language’s capabil-
ities, the size and quality of the open 

source community and open source 
projects, and because it’s based on 
standards. To a degree I’m pretty 
much envious of anyone working in 
an open standards based program-
ming language.

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. I think that with the release of CF MX 
7, ColdFusion has really begun address-
ing the requirements of Enterprise 
Applications. The Flex development 
team, without a doubt, had “Enterprise 
Solution” in mind from day one. Flex is 
a terrific example of how an Enterprise 
Application server should be. Everything 
about the way you develop Flex applica-
tions has the enterprise in mind, as well 
as encouraging scalable, architectural 
(application design) best practices. Flex 
makes the implementation of Enterprise 
RIAs a reality. I’ve been focussing on Flex 
a lot lately – it’s something that I, and the 
rest of the executives at AboutWeb, have 
prioritized as a top skill for our developers 
to master. We believe Flex has a terrific 
future.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. I’m very excited about seeing Flash 
become a more widespread agnostic 
platform. The idea of delivering rich 
interfaces to mobile phones, devices, and 
the desktop along with “traditional” web 
browsers is a very powerful one. With 
Flash as an interrface platform and PDF as 
a document format “platform” both con-
trolled by one company, there are some 
interesting possibilities. With regards to 
server side technologies, I’m very anxious 
to see how CF integrates and/or encapsu-
lates with existing Adobe server offerings. 
I’m also really excited about the doors 
that have been opened up with the intro-
duction of the Event Gateway framework 
in CFMX 7. Future gateways can now be 
introduced to help developers load test 
and administer their servers (and not 
just via a web interface, either) as well as 
interface with a myriad of devices and 
other environments.
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Name:  Bryan Hoff
Position: Freelance web designer, 

digital artist and animator – has 

worked on everything from movie 

and television effects to online 

games, 3D corporate animation, 

Flash, and traditional web site 

design.

Technologies used: “I use Dreamweaver 

almost exclusively. In my day-to-day 

work I don’t have much call for Flash, 

and I use Photoshop when I’m doing 

Web design, because I’m familiar with it 

and because I find its JPG output to be 

superior.”

 “I think Flash and the power of 
ActionScript have carried Macromedia this 
far, and it’s likely what drove Adobe to buy 
them.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. To put a bit of a twist on things, I’m 
actually looking forward to seeing some 
of FreeHand’s features – like transpar-
ent gradients – in future versions of 
Illustrator.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. I’m looking forward to hybrid ver-
sions of GoLive/Dreamweaver and 
ImageReady/Fireworks. Let’s see if it hap-
pens.

Name: Dean Utian
Position: Architect turned multime-

dia consultant, with experience in 

teaching Director and other digital 

applications – teacher of two courses 

at the University of New South 

Wales, Sydney, Australia and owner 

of a multimedia company called 

Multimedia Creative (www.multime-

diacreative.com).

Technologies used: Director MX 2004, 

Dreamweaver MX 2004, Fireworks MX 

2004, Flash MX 2004.

“One of Macromedia’s greatest contribu-
tions is their commitment to providing sup-
port and information to their users and the 
wider community.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. I have used a range of non-
Macromedia software, particularly Adobe 
products. Over recent years, my main 
envy is within Macromedia itself. I have 
envied the development and focus on 
Flash, which has far outpaced the devel-
opment of Director.

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to 
be in terms of technology and inspira-
tion?
A. Macromedia has promoted high 
impact multimedia experiences and 
has given the community a wealth of 
resources and exposure on their site. One 
of Macromedia’s greatest contributions is 
their commitment to providing support 
and information to their users and the 
wider community.

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A. Since Director is my primary 
Macromedia used product, I would like 
to see it get more exposure. Flash has 
had the limelight and main focus by 
Macromedia over the last few years and 
Director has been neglected. A percep-
tion has been created that Flash and 
Director are competing technologies 
and that Director will eventually be 
phased out. I would like to see Director 
become more part of the family of prod-
ucts. I’d like to see better integration of 
Photoshop and Illustrator into Director. I 
would also like to see an update of 3D in 
Director.

Name: Danny Patterson
Position: Manager of User Interface 

Development for POPstick (www.

popstick.com), a Boston-based 

interactive marketing company 

with an emphasis in Rich Internet 

Application development. A partner 

at CommunityMX and a member of 

Team Macromedia Flash. 

Technologies used: Flash, ColdFusion, 

Flash Remoting, Flash Communication 

Server, Flex.

“The Flash Platform is quickly emerging as 

the standard for delivering high-quality 
content and applications on the web.”

Q. In the last ten years what non-
Macromedia technologies (if any!!) have 
you envied?
A. I find that as a Flash developer, most 
people envy me. Because Flash Player is 
so ubiquitous, I can deliver applications 
to a very wide audience. And without 
much work, these applications can truly 
run cross-browser and cross-platform. The 
tools available to Flash developers are 
growing.  

Q. When it comes to enterprise-class 
development, what do you consider 
Macromedia’s main contribution to be in 
terms of technology and inspiration?
A. The Flash Player is definitely 
Macromedia’s largest contribution.  The 
Flash Platform is quickly emerging as 
the standard for delivering high-quality 
content and applications on the web. The 
ActionScript language is maturing nicely 
and I am encouraged by Macromedia’s 
involvement in ECMA International.  

Q. Having put the X into eXperience, 
what new areas are you looking forward 
to Macromedia’s team heading off into 
(including as part of a merged Adobe-
Macromedia)?
A.  The obvious answer to that question 
is the mobile market. However, creat-
ing mobile content and applications 
doesn’t really excite me personally 
until there is more advancement in the 
hardware for these devices. Once we 
are able to run Flash Player 7 or even 
8 on a cell phone, then I’ll jump on 
the bandwagon. Right now I’m most 
looking forward to the integration of 
Flash with Adobe video products like 
After Effects. The new video features 
that I’ve seen in Flash Player 8 are very 
cool, and we need some great new 
tools to take advantage of them. The 
advancement of ActionScript is also 
very exciting. I am looking forward to 
when ActionScript is fully compliant 
with the ECMAScript 4 proposal. And 
advancements within the ECMA group 
in areas like XML are also promising.  
ActionScript is already a good lan-
guage, but I am looking forward to its 
future. 
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esigners and developers 
worldwide couldn’t wait to 
take the Studio 8 beta version 
for a spin. We look at a selec-

tion of what’s been written so far in the 
UK about the Beta of the historic release.
	 “For most designers, Dreamweaver 8 
is the core product in the Studio 8 suite. 
Flash may have all the fancy moves but, 
if you were a shipwrecked web designer, 
marooned on a desert island with access 
to only one program, Dreamweaver’s the 
one you’d choose.”
	 “If Dreamweaver forms the founda-
tions of Studio 8, then Flash Professional 
8 is the gravity-defying edifice above it. 
... there are also a couple of new features 
that make you want to shake the devel-
opment team soundly by the hand.”
	  “Macromedia Studio, the software 
suite that includes web design’s two most 
important authoring tools, is back. And 
what a wait it’s been: the usual 18 month 
development and deployment cycle 
stretched out to a little over two years 
this time.” That was how the UK’s .net 
Magazine welcomed Studio 8 last month.
	  “The stuff in this release will blow 
your animated socks off, complete with 
perspective fixed, live drop shadows,” the 
magazine’s reviewer continued. “While 
Flash delivers a series of sizzling new 
features designed to make jaws drop and 
heads spin, updates to Dreamweaver are 
more levelheaded, concentrating on cod-
ing features and CSS. It succeeds on some 
levels better than others. Macromedia’s 
site authoring behemoth is the yin to 
Flash’s yang: the balancing element in an 
offering that blows hot and cold.”
	 The reviewer gave a little of the back-
ground to why Studio 8 was so relatively 
long in coming:
	 “Unfortunately, the last release, MX 
2004, suffered some early problems on 
the Mac. Reported performance issues 
were quickly identified and patched – but 
the suspicion remained that MX 2004 
may have been rushed to the market a 

little too soon. This overshadowed an 
otherwise impressive launch and perhaps 
it’s one of the reasons Macromedia took 
their time to get it right with this release.”
But praise for the development process 
this time round was fulsome. “The devel-
opment cycle has been remarkably open 
too. Macromedia pride themselves on 
listening to their users, talking to devel-
opers and giving them what they want. 
Both Dreamweaver and Flash teams have 
been blogging their development pro-
cess this time around, giving us glimpses 
of important features way ahead of the 
release date. When you’re number one 
in a field of one, it’s the kind of the thing 
you can afford to do.”
	 Dreamweaver 8 wows this reviewer.
	 The Dreamweaver updates met with 
a warm reception: “You can now embed 
Flash video into Dreamweaver created 
pages, complete with a playback control 
set of your own choosing, using a wizard 
based interface. If you’ve ever tried to 
navigate the minefield that is putting 
video online, this takes the pain and 
guesswork out of it completely.“
	 The review continues:
	 “CSS gets some serious attention with 
a newly unified CSS panel that enables 
you to edit styles without having to go 
into a full edit dialog or nip over to the 
Tag Inspector. There are new visual aids 
too, similar to those that help you select 
invisible tables. Now CSS block elements 
can be color coded, enabling you to see 
exactly where they are on your page. You 
can also choose how to render styles for 
different platforms too, or turn off style 
rendering completely.”
	 Then comes the first fly in the oint-
ment. “Macromedia says that it’s tweaked 
the CSS layouts in Dreamweaver’s design 
view so that they look more like they 
would in a browser,” the review notes. 
“However, Macromedia does seem to 
have overlooked the growing popular-
ity among hardcore designers of fluid 
layouts with relative positioning. The 

program lacks specific tools to deal with 
them and one W3C layout we tried to edit 
looked broken in Dreamweaver 8.”
One new coding tweak in particular 
was singled out for praise, the update 
to Dreamweaver’s code view: “Adobe 
GoLive scores few points over its rival but 
its hierarchical code view, enabling you 
to collapse the structure of a page into 
a branching tree, was one of them. Now 
Dreamweaver has something similar but 
more selective, right in the main code 
window. There’s also a new set of tools for 
working with code available from a new 
coding tool bar running down the side of 
the window.”
	 Flash Professional 8 gets a big 
thumbs-up too.
	 The British review then turns to Flash 
Professional 8. 
	 “If Dreamweaver forms the founda-
tions of Studio 8,” writes the reviewer, 
“then Flash Professional 8 is the gravity-
defying edifice above it.” 
	 “Now in its tenth year the package 
still packs surprises into every release. 
This one sees lots of cosmetic tweaks 
and minor revamps, as do all the tools 
in Studio 8, but there are also a couple 
of new features that make you want to 
shake the development team soundly by 
the hand.” 
	 “Image editing tools like Photoshop 
and Fireworks have long had graphic 
effects built in to them,” the reviewer 
notes. “Even the short-lived Adobe 
LiveMotion had filter effects. Now Flash 
has them, too, but Macromedia has taken 
an interesting approach to them. Instead 
of being hard rendered into a scene, 
Flash Graphic Effects are rendered in the 
player. So, for example, you can apply 
a drop shadow to an animating object. 
The shadow will change and mutate live 
– and there’s no additional overhead in 
your Flash file. There’s no need to convert 
vectors to bitmaps, either. The Filters 
panel appears as a tab in the Properties 
inspector, giving you a choice includ-

Studio 8: The Early Response

The Beta Version – Road-Tested in the UK
by mxdj news desk

d

beta
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ing glow, shadow, convolution, blur and 
other effects. Alpha transparency’s there 
too. The Filters sit on top of an entirely 
new level of code giving you pixel precise 
control over Flash elements through 
ActionScript – so those filters are just the 
tip of the iceberg for savvy programmers.”
	 He then turns to what he calls the 
“two massive innovations” in video: 
“Within the Flash authoring tool itself, 
you’ll find new video templates that 
enable you to quickly put together video 
control panels. No more messing with 
individual components and their parame-
ters. As if all that wasn’t good enough, the 
same technology that brings you graphic 
effects now enables you to specify alpha 
transparency in Flash video. In turn, this 
allows you to composite video elements 
over other Flash content – live.”
	 The mobile support is hailed too:
	 “One area of focus that must be 
mentioned though is Flash’s improved 
support for mobile content. Flash Lite 
export felt like an afterthought in Flash 
MX 2004. Now it’s fully integrated and 
ships with an interactive mobile emulator, 
which enables you to test Flash authored 
mobile content for a growing number of 
devices. There’s still no SVG Tiny support, 
though Flash Lite is growing in popularity 
and Flash is the best authoring tool for 
vector content there is. Now it’s the best 
video development environment and 
web application building tool there is, 
too.”
	 Verdict on pricing
	 Of Fireworks 9, the reviewer writes: 
“There are no ground breaking new 
tweaks here but every one of them is 
welcome. The biggest of the batch is the 
addition of 25 new blend modes and a 
couple of new filters. There’s a new set of 
sample buttons, animations and themes 
to help with production and the addition 
of a special characters panel. For us, the 
most useful changes were even smaller. 
The use of CSS in pop-up menu genera-
tion is one of them, while improved vec-
tor compatibility with Flash is another. 
Both guarantee better integration with 
other tools in the Studio 8 package.”
	 Then comes the overall verdict on the 
pricing structure of Studio 8:
	 “With so many tools available, both 
as part of the studio package and as 
standalone tools, the pricing structure is 
quite complex. Generously, Macromedia 

are enabling users to upgrade from 
any previous version. Flash Basic is the 
anomaly here. It’s cheaper to upgrade 
to Flash Professional than buy Flash 
Basic on its own – and it’s not available 
as part of Studio. At £699 [Editor’s note: 
remember this was a UK review; the US 
price, as many MXDJ readers are aware, 
is $999] for the full version of Studio 8, 
it’s a big investment. Think about what 
you get for your money though; a bundle 
without a single strip of fat in it. Studio 
8 does everything you could ask of a 
batch of web tools. With this installed on 
your machine, there’s really no need for 
anything else. In that sense it offers bril-
liant value for money. The upgrade price 
is even nicer [Editor’s note: $399 in the 
US] – the updates to Flash are worth the 
money alone.”
	 The UK review ends as it began, 
enthusiastically. 
	 “Some might say that the Adobe’s 
acquisition of Macromedia will make a 
few of the tools in the Studio 8 redundant 
in a couple of years. We can say with 
confidence, however, that you’ll see fur-
ther versions of Flash, Dreamweaver and 
Contribute, at the very least.”
	 “The functionality of Fireworks and 
FlashPaper will live on, even if their 
names do not. Don’t miss out by trying 
to second-guess what the future holds, 
though – if you’re serious about web 
design, this is the package for you.”

MXDJ News Desk gathers stories, 

analysis, and information from around 

the world of software design and devel-

opment and synthesizes them into an 

easy to digest format for Macromedia 

designers and developers.

“For most designers, 
Dreamweaver 8 is the core 
product in the Studio 8 suite. 
Flash may have all the fancy 
moves but, if you were a 
shipwrecked web designer, 
marooned on a desert island 
with access to only one program, 
Dreamweaver’s the 
one you’d choose.”
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n April 18, 2005, as we 
all know, Adobe Systems 
Incorporated announced 
a definitive agreement to 

acquire Macromedia in an all-stock 
transaction valued at approximately $3.4 
billion. This is a look back, sideways, and 
forwards, based on 

what’s been happening since then.
	 After the inevitable wave of early 
name speculation subsided...would the 
company be renamed Adobomedia? 
Macrodobedia? AcroMacrobe?...both 
Macromedia’s Chief Software Architect 
Kevin Lynch and Adobe’s CEO Bruce 
Chizen made it clear to MXDJ (http://

mxdj.sys-con.com/read/49240.htm) 
and the San Francisco Chronicle 

respectively that the name 
of the combined company 
after Adobe had purchased 
Macromedia was going 

to be Adobe pure and 
simple. Or, as the FAQ 
promptly displayed 
on the web phrased 
it (http://www.adobe.
com/aboutadobe/
invrelations/adobe-

andmacromedia_faq.
html#q6):

What Will Be 
The Name of the 
Combined Company? 

Adobe Systems 

Incorporated.

	 There 
was no 

margin 
of 

error 

either so far as the executive pecking 
order was concerned. As early as April 18, 
both Adobe and Macromedia carried on 
their web sites the following statement:
	 In the combined company, Chizen will 
continue as chief executive officer and 
Shantanu Narayen will remain president 
and chief operating officer. Stephen Elop, 
president and chief executive officer of 
Macromedia, will join Adobe as president 
of worldwide field operations. Murray 
Demo will remain executive vice presi-
dent and chief financial officer. Dr. John 
Warnock and Dr. Charles Geschke will 
remain as co-chairmen of the Board of 
Directors of the combined company and 
Rob Burgess, chairman of the Macromedia 
Board of Directors, will join the Adobe 
Board.
	 This was fleshed out a little in terms 
of reporting structure [my emphasis 
below] in the FAQ (http://www.adobe.
com/aboutadobe/invrelations/adobeand-
macromedia_faq.html#q21):
	 Bruce Chizen will be the chief execu-
tive officer of the combined company. 
Shantanu Narayen will be the president 
and chief operating officer reporting 
to Chizen. Macromedia’s current chief 
executive officer, Stephen Elop, will be 
president, Worldwide Field Operations 
also reporting to Chizen. In this role, Elop 
will be responsible for Adobe’s sales, field 
marketing, professional services, sales 
operations, customer service and techni-
cal support. Murray Demo will be execu-
tive vice president and chief financial 
officer reporting to Chizen. 

The FAQ added:

	 Additionally upon close of the trans-
action, we anticipate other members of 
Macromedia’s senior management will 
be joining the combined company in key 
leadership positions.

Adobe-Macromedia 

Press Release, \18 

April 2005 
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“Microsoft Is the 
Competitor”
	 The goal of the acquisition was and is 
for the post-transaction Adobe to be able 
to offer to the customers of the combined 
company “a broad set of tools, services 
and solutions for design, digital media, 
documents, and collaboration” as well as 
developing new market opportunities 
around mobile and enterprise solutions 
that build upon the Adobe and Flash 
platforms. 
	 This is key. Adobe saw and sees 
the functionality of Adobe PDF and 
Macromedia Flash as complementary, 
enabling the deployment of an industry-
defining, cross-media, rich-client technol-
ogy platform across multiple operating 
systems and devices.
	 And where does Microsoft fit into all 
of this? The answer was already spelt out 
by Bruce Chizen in 2004, when he spoke 
to the Knowledge@Wharton newsletter 
published by the Wharton School of the 
University of Pennsylvania, recognized 
around the world for its innovative lead-
ership and broad academic strengths.
	 “When I think about competitors,” 
Chizen told the newsletter, “there’s only 
one I really worry about. And it’s one that 
happens to have $35 billion in revenues 
and $50 billion in the bank. And it hap-
pens to be in the software business. 
Microsoft is the competitor, and it’s the 
one that keeps me up at night.”
Wharton legal studies professor Kevin 
Werbach was quick in April to say that 
the transaction makes a lot of sense for 
both firms:
	 “For Macromedia, it was unclear 
whether the company could have sur-
vived in the long run as an independent. 
While its business has been growing 
rapidly especially in non-PC gadgets such 
as cell phones and personal digital assis-
tants.”

	 As Macromedia’s former CEO, Robert 
Burgess, explained in an interview with 
Knowledge@Wharton in October (http://
knowledge.wharton.upenn.edu/index.cf
m?fa=viewArticle&id=1059), Macromedia 
didn’t have the girth to compete with 
larger companies like Microsoft. 
	 A key passage in the Wharton inter-
view came when Burgess was asked 
(remember, this was back in 2004) to 
what extent Adobe competed with 
Macromedia: “Very little” was Burgess’s 
immediate response. He elaborated that 
the only two cases of point products 
where the two companies competed 
were Adobe Illustrator/FreeHand and 
GoLive/Dreamweaver:
	 “FreeHand competes with Illustrator 
– it’s probably 85% [Adobe Illustrator] 
/ 15% [Macromedia FreeHand] mar-
ket share -  something like that. 
Dreamweaver has about 95% market 
share and [Adobe] GoLive has about 5%. 
Those are the two cases of point products 
where we compete.” 
	 Although FlashPaper produces both a 
[Flash] SWF-based document format and 
a PDF format, Burgess was adamant:
	 “Seriously, I believe that the 
amount of overlap between Adobe and 
Macromedia - five years ago - was sub-
stantial. And now, it is very little.” 
	 When asked whether this a conscious 
move, Burgess explained that what hap-
pened was that Adobe concentrated on 
some businesses - and really got going 
with them. 
	 “Adobe’s been a document-centric 
company, and it’s done very, very well. 
Adobe invested in Acrobat for a long 
time and it was unwavering. And it finally 
broke through - and that’s a great busi-
ness. Photoshop’s a great business for 
Adobe - we don’t have anything that 
competes with that. Video’s a great busi-
ness for them, as is PostScript. In all their 

businesses, Adobe has lots of growth and 
lots of profit. We don’t participate there.” 
Meantime Macromedia took a different 
path, Burgess pointed out:
	 “And, similarly, we got going with 
web publishing - then multimedia on the 
Internet, and Breeze, and some of these 
high-growth products. Adobe doesn’t 
have anything that competes with these 
products. So there is historical, legacy-
level overlap, but it’s really minor. When 
I look at where the companies are going, 
there’s very little overlap. And I think 
Bruce Chizen would say the same thing.”
	 As we now all know, a few months 
later...he did! From Adobe’s perspective, 
the deal works because Macromedia is so 
certain to provide future growth opportu-
nities. Kendall Whitehouse, senior director 
of information technology at Wharton, 
characterized the Adobe-Macromedia 
transaction as follows: “a classic case of 
merging for strategic reasons.”
	 “Adobe has a broad product portfolio, 
but Macromedia provides a pathway to 
the future,” Werbach observed. “Adobe 
has a strong publishing position, but 
that’s being eaten away by the web. The 
PDF is a bridge from paper to the web 
that may not always be needed. Flash is 
in mobile phones and is the rich interface 
in Tivo boxes and airport kiosks.”
Voices For – and Against
	 Sun’s Tim Bray couldn’t resist pitching 
in on the day the deal was announced 
back in April, via his “Ongoing” blog, with 
the following entry entitled: “Adobe + 
Macromedia = ?”
	 “Seems straightforward to me. Adobe 
is in at the center of print production 
(PhotoShop & friends, InDesign, PDF), 
while Macromedia’s DreamWeaver is the 
single most important Web-design prod-
uct. Dave Shea says this might be about 
Flash, but let me suggest exactly the 
opposite: if you’re hitching your career 

“By combining the passion, creativity, 
and technology of two leading-edge companies, 
we will continue to drive innovations that 
help people and organizations everywhere 
communicate better.”

Macrmedia’s 
Stephen Elop 
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to Flash, it might be a good time to look 
at alternatives. Why’s that? Because, near 
as I can tell, Macromedia has never made 
any serious money with Flash. They’ve 
accomplished one of the great, heroic, 
marketing coups of all time, getting the 
plug-in onto substantially every desktop 
on the planet; and this bought them, uh, 
what exactly? They sell authoring tools, 
but seriously, how many Flash designers 
does the world need? Anyhow, most of 
the good things you can do with Flash, 
you can do about as well with DHTML 
(oops that’s called AJAX now) and your 
“back” button still works. I guess there’s 
no reason to actually shut Flash down, 
the tool revenue must about cover the 
engineering costs. But Adobe, historically, 
has been good at focusing on what works 
and dropping the distractions. (Can you 
remember PageMill?) Flash is a distrac-
tion.” 
	 Before long he was set to rights be 
members of the Flash community world-
wide, and soon afterwards added to his 
blog entry:
	 “[Update: Smell something burning? 
That would be me, sizzling in a torrent of 
Flash-flavored flame.]”
	 Macromedia’s John Dowdell for exam-
ple had a nice counter-quip: 
	 “Funny, you’d sorta think Sun would 
be bullish on a cross-platform, cross-
browser “write once play anywhere” kind 
of thingy, wouldn’t you...? ;-)”
	 But what of those more bullish about 
the transaction? For example, Russell 
Beattie (http://www.russellbeattie.com/
notebook/1008422.html) wrote:
	 “Of all the areas and products that 
Macromedia covers, for Adobe to point 
out specifically the mobile area in their 
merger FAQ means (to me) that Flash Lite 
isn’t going to be forgotten. And honestly, 
with Adobe’s worldwide market presence 
they might be able to do a much better 
job than Macromedia has done so far to 
get Flash on the handsets (in the West). 
I can see a combined Flash/SVG player 
(Flash Lite 1.1?) from Adobe becoming a 
really viable platform. I look forward to it 
because I think as the handsets mature, 
Flash will become a better way to create 
entertainment-oriented content than 
Java just like it has in the browser. Now 
Adobe can spend some of the energy 
they’ve been expending promoting SVG-
T towards Flash as well, and that’s a good 

thing.”
	 And Jeremy Allaire, former CTO 
of Macromedia and therefore a man 
whose view must surely be worth bear-
ing strongly in mind, told PaidContent.
org (http://www.paidcontent.org/
pc/arch/2005_04_18.shtml#013267): 
“Macromedia lost the enterprise publish-
ing race to Adobe, and Adobe lost it with 
the Web publishing community. So the 
deal combines the best of both worlds. It 
gives Macromedia a huge sales channel, 
especially on the enterprise side. This will 
probably make the channels as strong as 
say Microsoft has.”

July-August Update
	 In July, as it often does in deals involv-
ing software, with all its complications 
and nuances, the US Department of 
Justice requested additional information 
from the two companies. As arstech-
nica (http://arstechnica.com/news.ars/
post/20050711-5079.html) noted at the 
time:
	 “The DOJ is especially interested in 
what will happen once the old GoLive vs. 
Dreamweaver and Illustrator vs. Freehand 
competition ceases under the suddenly 
larger Adobe umbrella.”
	 “It’s not unusual to see a second 
request (for information) in cases were 
the parties serve the same market, 
especially in software” attorney Connie 
Robinson told arstechnica (she heads up 
the antitrust department at Kilpatrick 
Stockton). “Unlike a widget, where you 
can see it and touch it,” Robinson added, 
“software is harder to get your hands 
around and understand.”
	 In August the most interesting devel-
opment was probably the birth of http://
blogs.adobe.com, which syndicates blogs 
from the likes of Mark Niemann-Ross, 
the Adobe Developer Evangelist working 
with third-party developers on  InDesign, 
Illustrator and anything else that needs 
on the Creative Suite side of Adobe and 
Lori DeFurio, the Acrobat (and PDF) 
Developer Evangelist.
	 The founder of the site was Adobe 
Canada’s Gavin McKenzie, who wrote 
(http://blogs.adobe.com/gavin.mcken-
zie/2005/08/beginnings.html):
	 “I’ve been working towards the 
launch of blogs.adobe.com for some 
time, along with a diverse virtual team, 
and at least for the very near term I will 

continue to have a role in the care and 
feeding of the site. Over the coming 
weeks I fully expect to discover issues 
and areas for improvement — please let 
me know either via comments or email if 
you spot something that isn’t working or 
have a suggestion. Suggestions for types 
of blogs that you wish to see are encour-
aged as well.”
	 So that was in itself a strong indica-
tion that communicating directly with 
customers is a core value the combined 
company can be expected to maintain.

Next Steps...
	 What next? Although we cannot 
know (or say) what is going on behind 
closed doors, and for legal reasons the 
combined company will not be able to 
create a joint product roadmap until 
after the transaction is closed, some clear 
pointers can perhaps nonetheless be 
given.
	 As anyone who enjoyed last month’s 
historic Special Studio 8 issue already 
knows, while Macromedia may be 
moving beyond “MX” – which letters 
originated from its desire to underline 
the importance and uniqueness of the 
“Macromedia eXperience” – it is certainly 
not abandoning its commitment to the 
extent to which Experience Matters. 
“Great experiences enable great business” 
remains as true as ever.
	 Indeed we can all look forward to a 
widening and deepening of that com-
mitment, with the addition – with this 
month’s shipping of Studio 8 – of a sec-
ond “E,” namely Expressiveness.
	 As Macromedia’s Flash evangelist 
Mike Downey said in the Special Issue:
	 “I think we’ve done a lot of major 
work in this release about productivity, 
standards support, and workflow. But the 
work we’ve done to allow designers and 
developers to be more expressive with 
their content will have the biggest impact 
on the web.”

DoJ Approval Is All That’s 
Needed Now
	 On August 24, as this issue went to 
press, the respective shareholders of 
Adobe and Macromedia overwhelmingly 
approved the acquisition in separate 
special stockholder meetings. The stock-
holders of each company voted as fol-
lows: of the 75.0% of outstanding Adobe 
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shares voted, approximately 99.0% were cast in favor of 
the acquisition; of the 73.2% of outstanding Macromedia 
shares voted, approximately 99.8% were cast in favor of 
the acquisition. 
	 In an accompanying announcement, the companies 
stated:
	 “Pursuant to the terms of the acquisition agree-
ment, holders of Macromedia common stock will receive 
1.38 shares of Adobe common stock for each share of 
Macromedia common stock they own at the closing 
of the acquisition. The companies anticipate that the 
transaction will close in Fall 2005, subject to appropriate 
regulatory approvals and the satisfaction of other closing 
conditions.”
	 When the transaction closes, Macromedia’s stock-
holders will own approximately 18% of the combined 
company on a pro forma basis. So far as products 
go, from here on the Adobe-Macromedia integration 
process will be managed by a so-called “Integration 
Program Office,” consisting of one Integration Lead 
from each company. The Integration Leads are Adobe’s 
vice president Corporate Services, Jim Briody, and 
Macromedia’s executive vice president and CFO, Betsey 
Nelson, who joined Macromedia in 1996 to lead mergers 
and acquisitions and has served as the company’s CFO 
since 1997.
	 The Integration Program Office will be overseen by 
an Integration Steering Committee chaired by Shantanu 
Narayen and consisting of: Bruce Chizen (pictured), CEO 
Adobe; Stephen Elop, president and CEO, Macromedia; 
Shantanu Narayen, president and COO, Adobe; Murray 
Demo, executive vice president and CFO, Adobe; 
and Theresa Townsley, senior vice president, Human 
Resources, Adobe.

And the Last (Irreverent) Word Goes 
To...
	 In a world that is often dull, technology and laughter 
should not be complete strangers to one another. Life, as 
they say, is too short for that. Accordingly let’s finish with 
the mischievous soul who made this delightfully mischie-
vous post to Slashdot.org, when it reported the approval 
by both companies’ shareholders of the deal (http://slash-
dot.org/comments.pl?sid=160364&cid=13424792):
“Now I only have one corporation to hate on instead of 
two. This frees up hatred for new and upcoming busi-
nesses.”

Additional Resources
Adobe-Macromedia Acquisition website
http://www.adobe.com/aboutadobe/invrelations/adobe-
andmacromedia.html

Macromedia Blogs
http://weblogs.macromedia.com/mxna/

Adobe Blogs
http://blogs.adobe.com  

The following e-mail was sent to all employees of 

Adobe Systems Incorporated on April 25, 2005: 

Date: April 25, 2005 

To: All Adobe Employees 

From: Bruce Chizen and Shantanu Narayen 

Re: Summing Up Last Week—
Macromedia Acquisition 
	 Last week was an exciting time for 

Adobe as we announced our plans to acquire 

Macromedia. We spent the majority of the 

week speaking with employees, customers, 

partners, investors, analysts and press, and 

we’re pleased to report that all have been 

very supportive of our vision to bring the 

companies together. 

	O ur energy and excitement about the 

future continues to grow each day. And, 

we’ve heard from many of you that you 

share the same feeling. Many of you have 

asked, “How can I help?” You can help in 

two important ways: 

	 First, stay focused on our business—we 

must continue to operate independent of 

Macromedia until the close of the transac-

tion. Our future success as a combined 

company is critically dependent upon how 

successful each company is in executing 

its own business strategy. Both Adobe and 

Macromedia have been very successful in 

the recent past. This is why many external 

parties see the logic of this deal and believe 

in our ability to successfully integrate the 

two companies. We need to continue our 

trend of success. 

	 Second, be supportive of the integration 

process. Deals of this nature can take sev-

eral months or longer to close, and due to its 

size and scope, this acquisition will require 

a very tightly controlled integration process. 

The Integration Program Office, under the 

leadership of Jim Briody, is forming—with 

the functional integration leads currently 

being selected by the ETeam. Look for email 

updates from the Integration Program Office 

in the next couple of weeks describing the 

integration process, structure, and the ini-

tial integration team members. Additionally, 

the Integration Program Office will send out 

periodic email updates on the integration 

planning. 

	 We have a great year ahead with tre-

mendous opportunity. Let’s work together to 

ensure our future success by executing flaw-

lessly on our business today! 

—Bruce and Shantanu 
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	 Fortunately for us, the World Wide 
Web’s creator, Tim Berners-Lee, not only 
created a protocol for retrieving docu-
ments (the HyperText Transfer Protocol, 
HTTP), but he also created a standard 
language for creating the documents to 
be retrieved called the HyperText Markup 
Language (HTML). Those of us who have 
traveled the way of the Internet since 
its inception will recall how quickly it 
became proprietary in its structure and 
abilities. Prior to the so-called browser 
wars, the World Wide Web was fragment-
ing into competing languages, overlap-
ping functionality, and proprietary code 
that turned any attempt at universal 
Web design into a frustrating experience. 
Many of us have felt the frustration of try-
ing to write Cascading Style Sheets that 
displayed our designs in an identical, if 
not similar, fashion across multiple Web 
browsers and platforms. In addition to 
presentation problems, we also experi-
enced functionality issues with JavaScript 
(from Netscape) vs. Jscript (from 
Microsoft). The browser wars between 
Netscape Navigator and Internet Explorer 
really brought the issue to the forefront 
as the two browsers competed to provide 
a richer, more dynamic experience for 
providers and end users alike.
	 The subsequent creation of the World 
Wide Web Consortium and its recommen-
dations (read: standards) has done much 
to alleviate the problems caused by the 
browser wars. The browser manufacturers 
themselves have also contributed to the 
solution by upgrading their browsers to 

render HTML code in a more consistent 
way. Thus, we have seen a return to the 
original plan, which called for a Web 
document established upon a standards-
based language. 
	 While Web designers today under-
stand the need to write code that works 
in all browsers and on all platforms, many 
simply do not appreciate the conse-
quences of non-standard code. Today’s 
Web browsers ask much from the humble 
HTML document. The Web page of late 
has become a starting-off point for infor-
mation. Eventually the content of the 
Web page is used to formulate printed 
pieces, populate forms (including PDF 
pages), and some Web pages are compo-
nents of an advanced Web application or 
software that runs via the Internet. Not all 
Web pages can fulfill these purposes. In 
order to use a Web page to create a PDF, 
or to populate a back-end database, or 
to feed a Flash application, the content 
must be consistent; it must be standard. 
The standard that promises the most pos-
sibilities is XHTML. Other standards that 
help multipurpose your content include 
Cascading Style Sheets, XSL-T, and XML.
	 The purpose of this article is to dem-
onstrate how Dreamweaver MX 2004 
can help you write standards-compliant 
code. You will learn how to ensure your 
documents are written in XHTML, or if 
you prefer, HTML 4.0, etc. You will learn 
how to build accessibility in your docu-
ments that will help your Web pages to 
be rendered by PDAs and cell phones, as 
well as desktop browsers and printers. By 

writing XHTML-compliant code and using 
an external stylesheet, you will be able to 
exploit all of the multipurposing possibili-
ties that are available.

What Type of Document 
Should You Write?
	 If you would like to repurpose the 
data in your Web page, the most flexible 
format is XHTML. When your document 
is written in XHTML it means that it is an 
XML application. As such, it is pure data 
and can be rendered for any purpose. For 
example, by using the XML stylesheet 
language called XSLT, you can transform 
XHTML Web pages into any other type 
of format, including any of the new 
Microsoft Office Markup languages that 
such as WordprocessingML for Microsoft 
Word and SpreadsheetML for Microsoft 
Excel. You can also transform the XHTML 
into an XML file that is suitable for import 
into many applications, including Flash 
to create dynamic Flash applications, and 
Adobe InDesign to create printed pieces. 
The possibilities are becoming endless as 
more applications become XML-compat-
ible.
	 On the other hand, if you are rework-
ing older Web pages that need to be 
viewed in early (before standards-based) 
browsers, you may want to ensure that 
they are written according to the rules of  
HTML that were in use at the time of the 
browser release (HTML 4.0, for example).
	 The solution in both cases is to 
declare a document type at the begin-
ning of your Web page that announces to 
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the Web browser what version of HTML 
you are writing. In the “New Document” 
dialog box, Dreamweaver offers the 
opportunity to ensure that you cre-
ate XHTML. Figure 1 shows the “Make 
Document XHTML Compliant” check-
box. If you do not check this box, then 
Dreamweaver will write the Web page 
in HTML 4.01 Transitional, which means 
that the document may use deprecated 
presentational elements such as the font 

tag. This makes the document backwards 
compatible for older Web browsers. When 
creating a document that is not XHTML 
compliant, Dreamweaver generates the 
code shown in Listing 1. Enabling the 
“Make Document XHTML Compliant” 
checkbox would result in the DOCTYPE 
shown in code in Listing 2.
	 Once you have written your web 
page as XHTML, you can validate it within 
Dreamweaver to make sure that you have 
not broken any of the rules of the XHTML 
language. If you wish to exploit the XML 
capabilities of XHTML, your code must 
be valid. To validate your code using 
Dreamweaver:
1.	 Open the Web page you have written 

in XHTML.
2.	 From the Window Menu, choose 

“Results” or hit F7 to bring up the 
“Results Panel.”

3.	 Click the Validation tab at the top of 
the Results Panel.

4.	 Click the green arrow on the left of 
the Results Panel and choose “Validate 
Current Document.” Note that you can 
also validate an entire site, or selected 
files from the site. If the site contains 
no errors, the results panel will display 
as shown in Figure 2.

 
	 The Dreamweaver validator looks at 
the DOCTYPE declared in the beginning 
of the document and checks it for errors 
against that DOCTYPE. Because we chose 
to write XHTML Transitional, the results 
panel would not indicate any errors 
even if we used deprecated tags such as 
<font> and <b>. However if we change 

the DOCTYPE to XHTML strict, the valida-
tor would find our errors, as shown in 
Figure 3. Dreamweaver does not provide 
a method for changing the DOCTYPE 
declaration other than the “Make 
Document XHTML Compliant” checkbox. 
Therefore, in order to write XHTML strict, 
you must manually change the DOCTYPE 
in code view. See the Macromedia 
exchange for an extension that allows 
DOCTYPE changes. For information on 
how to change the default DOCTYPE 
in Dreamweaver, see MX Developer’s 
Journal online at http://mxdj.sys-con.
com/read/45940.htm. The DOCTYPE 
should read as shown in Listing 3. 
	 The results panel also allows you to 
save the validation results as an XML file 
and view the results in a Web browser 
as an HTML file. Double-clicking the 
error message will highlight the code in 
Dreamweaver.
	 Outside of Dreamweaver, you can 
also validate your code using the W3C’s 
Validator Service at: http://validator.
w3.org/. You can use the Validate by 
Upload section of the page and browse 
to the file you wish to validate. Figure 4 
shows the results of validating the same 
page that Dreamweaver validated earlier 
(with the DOCTYPE XHTML Transitional) 
that indicated no errors. The W3C 
Validation Service is a bit fussier and 
returns an error message because our 
page uses an image tag without an alt 
attribute.
 
The DOCTYPE Switch
	 Declaring DOCTYPES becomes espe-
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<!DOCTYPE HTML PUBLIC “-//W3C//

DTD HTML 4.01 Transitional//EN”

“http://www.w3.org/TR/html4/

loose.dtd”>

<html>

<head>

<title>Untitled Document</title>

<meta http-equiv=”Content-Type” 

content=”text/html; charset=iso-

8859-1”>

</head>

<body>

</body>

</html>

<!DOCTYPE html PUBLIC “-//W3C//

DTD XHTML 1.0 Transitional//EN” 

“http://www.w3.org/TR/xhtml1/DTD/

xhtml1-transitional.dtd”>

<html xmlns=”http://www.

w3.org/1999/xhtml”>

<!DOCTYPE html PUBLIC “-//

W3C//DTD XHTML 1.0 Strict//EN” 

“http://www.w3.org/TR/xhtml1/DTD/

xhtml1-strict.dtd”>

<!DOCTYPE html PUBLIC “-//W3C//

DTD HTML 4.01 //EN”>

<script language=”javascript”>

function displayMode() {

	theMode = document.compatMode;

	alert(theMode);

	}

</script>

<form> 

  <input type=”button” 

name=”Button” value=”Display 

Mode” onClick=”displayMode()”> 

</form>
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cially helpful when you want to ensure 
that your CSS code is rendered as you 
intended. Today’s standards-compliant 
Web browsers are really two browsers in 
one. Technically speaking, it is one Web 
browser that is capable of rendering in 
two modes: “standards-compliant mode” 
and “backwards-compatible mode,” 
also known as “quirks mode.” The Web 
browser reads the DOCTYPE line, which 
triggers the correct rendering mode. 
For example, if your DOCTYPE declares 
that you are writing XHTML 1 Strict (see 
Listing 3), this means that your code 
uses only XHTML elements that relate to 
the document structure (no deprecated 
markup is allowed); the presentation 
information is left entirely to a Cascading 
Style Sheet. How that Cascading Style 
Sheet is rendered depends on the 
browser’s rendering mode (either stan-
dards-compliant or backwards-compat-
ible). 
	 Recall the browser wars and the 
subsequent years when Web brows-
ers rendered CSS code differently from 
one browser to the other. One of the 
most prevalent problems has been the 
way the different browsers render DIV 
tags and their associated height, width, 
border, margins, and padding – the 
so-called box model.  Essentially, the 
problem lies in the manner in which 
Internet Explorer understand this box. 
If you would like a div to be 100 pixels 
wide with padding of 10 and a border of 
10, you simply write the CSS width prop-
erty equal to 100 pixels. With Internet 
Explorer, however, your div box would 
be 40 pixels smaller than you expect, 
because it subtracts from the width the 
10 pixel padding on the right and left 

as well as the 10 pixel border on the 
right and left. This is just one of several 
problems with the way some older (non-
standards compliant) browsers render 
CSS. There is a possible solution. Imagine 
having to rework an old Web site that 
is several hundred pages because the 
new browsers render the CSS in a stan-
dards-compliant way, but you wrote the 
page to work in the browsers in use at 
the time you created it (non-standard, 
work-arounds, CSS hacks, etc). Rather 
than upgrade several hundred pages, 
you can “downgrade” the browser. In 
other words, force the browser to render 
your page in “backwards-compatible” 
mode or “quirks mode.” To do this you 
simply declare the correct DOCTYPE. 
Unfortunately, declaring the “correct” 
DOCTYPE can be tricky, because brows-
ers can respond to the same DOCTYPEs 
differently. For example, the DOCTYPE 
in Listing 4 will trigger “standards-com-
pliant” mode in Mozilla 1.0, Netscape 
6.0+, Safari 1.0+,  Internet Explorer 6.0+, 
and Opera 7.1+, but will trigger “quirks” 
mode in Internet Explorer 5 for the Mac.
	 You can use a simple JavaScript for 
testing purposes to see if the DOCTYPE 
you are using will trigger “standards-
compliant mode” or “quirks mode.” Copy 
Listing 5 to the head section of the Web 
page you wish to test in Dreamweaver 
and Preview in Browser.
	 You will also need to add a button to 
trigger the JavaScript. Copy the code in 
Listing 6 to the bottom of the Web page 
that you wish to test.
	 If your code triggers “standards-com-
pliant” mode” in Internet Explorer, you will 
see the alert box shown in Figure 5, oth-
erwise IE will display “Backcompat.” Opera 

7.5+, Mozilla 1.0, Firefox 1.0 and Netscape 
7.2+ will also display “CSS1Compat.” If 
Opera is rendering in quirks mode the 
alert box will display “Quirksmode.” If 
Firefox 1.0, Netscape 7.2+, or Mozilla 1.0 is 
rendering in quirks mode the dialog box 
will display “Backcompat.”
	 Dreamweavers’ ability to write stan-
dards-compliant code allows you to cre-
ate Web pages that can then be used for 
other purposes. For example, XHTML can 
be transformed into XML, which can then 
be used to drive a Flash Web application. 
XHTML code can be reused in a similar 
way through ColdFusion, where the XML 
file replaces a database. Perhaps the 
greatest benefit in writing and validating 
our standards-compliant code is knowing 
that our code is ready for future browser 
releases, which means less re-work for 
us. As Web designers, we should commit 
ourselves to the future of the Internet by 
supporting standards. Macromedia as a 
software developer has committed itself 
to creating a product that writes code in 
accordance with the accepted standards 
of today.  

Kevin Ruse is the author of Web 

Standards Design Guide published 

by Charles River Media, Inc. The book 

explores the current standards: XML, 

XHTML, CSS, XForms, and XLink, as well 

as workflow issues that involve these stan-

dards. kevin@kevinruse.com
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ayers are a special kind of HTML 
elements that can be used as a 
container to hold other HTML ele-
ments and to show them dynami-

cally using JavaScripts. We can stack 
more than one layer on top of each other. 
One or more layer can be made visible 
dynamically, by hiding others. But using 
Macromedia Dreamweaver you can do 
all this without even knowing JavaScript 
or coding.
	 In this tutorial we are going to 
use multiple layers stacked over one 
another, and make it viewable, when you 
mouseover an image. In this case study 
I have taken 2 rollover images: Image1, 
Image 2, and three layers: Layer1, Layer2 
and Layer3. 
	 When we mouse over on the Image1, 
the second layer will appear while Layer1 
and Layer 3 will be hidden along with its 
content. Likewise for the Image 3, Layer1 
and 2 will be hidden and only Layer3 will 

appear with its content. When we mouse 
out from the images, Layer 1 will come up 
again. 
	 To achieve this follow the steps and 
enjoy!

1. Creating rollover Images
	 First as I said let us create 2 Images. 
We can use Macromedia Fireworks to 
create the images. In our case I have 
designed 4 buttons; 2 for the up state 
and 2 for the down state. 
	 After designing the buttons, open 
a new page in Dreamweaver and cre-
ate a 2X1 table. Now Insert the images 
using, Insert>Interactive Images>Rollover 
Image. Browse and select the first one for 
the up state and the second one for the 
down state. ( I am assuming you have put 
the images in the proper folder.) 
	 Now do the same for the next image, 
so that both the images are in the first col-
umn of the table as shown in this example.  

 

2. Placing Layers
	 Open Insert>Layer and place the 
Layer1. Move the layer into column2 of 
the table. Now you can write the content 
inside the Layer. Select the layer in the 
Properties Inspector and select Overflow 
as ‘visible’. This makes this first layer the 
default layer and makes it visible while 
the page is being loaded.
	 Note down the position of the Layer 
(566px and 163px). Insert the second and 
third layers on the same position, so that 

they will sit over the first layer. 
	 Now insert the text on those layers. 
(Note: Due to the overlapping of layers 
the text may not be clear. So, you can 
place the layers somewhere else, write 
down the text and then change the posi-
tion of the layers to sit on the same posi-
tion as the first layer.)

3. Changing the Layer 
Properties
	 Select Window>Layers. You will get 
the Layer Inspector, with all the three 
layer details. Select Layer2 and Layer3 
and if the eye is open click on it to close 
it for both of them. In the properties 
Inspector you can see the OverFlow is 
selected as hidden for Layer2 and Layer3. 
This enables Layer2 and 3 to be hidden 
while the page is loaded.
 
4. Adding Behaviors
	 Now select the Image1 where we are 
going to add the dynamic Layer effects. 
Then Open Window > Behavior. You can 
see the Events and actions created by 
Dreamweaver for the Rollover Images 
which we did in step 1. 
	 Click on the  button and select “Show-
hide Layers”. You will get this box to ‘Show 
or Hide” the Layers.
	 Now do the following:
a. Select Layer1 than click on ‘Hide’
b. Select Layer2 and click on ‘Show’ then,
c. Select Layer3 and click on ‘Hide’.
	 This action will make Layer1 and 3 dis-
appear and show Layer2 whenever you 
mouseover Image1.
	 You can also see the new JavaScript 
events created by Dreamweaver in 
the Behaviors Inspector. Here the new 
onMouseOver and onMouseOut with 
Show-hide Layers as actions. 
	 Note here that you can use other 
events also as you like. For example 
instead of onMouseOver you can use 
onClick. To do this you need to click on 
the tiny black, inverted arrow next to the 
event. Use this to select other events, ie 

Dreamweaver for Beginners 

Creating dynamic layers with interactive image rollovers 
by benny alexander
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OnClick, Down etc.,. 
	 At the foot of the list there is a category which allows you to choose which 
browsers to support, make sure a check is next to 4 and higher browsers. (Only 
after choosing the browser 4 or higher you will be able to see all the Events in a 
list)
	 Follow step 4 by selecting Image2. Then, 
a. Select Layer1 than click on ‘Hide’; 
b. Select Layer2 and click on ‘Hide’ then, 
c. Select Layer3 and click on ‘Show’. 
	 This action will make the Layer1 and Layer2 disappear and show Layer2 while 
you move your mouse over Image1.

5. Bringing Default Layer Again
	 Now as a final step, you need to bring back Layer1 when you move your mouse 
out of the Image (or when you mouse away from the images to somewhere on 
that page). Select Image1 and click on the  button and select “Show-hide Layers”. 
You will get a box to ‘Show or Hide” the Layers.
	 Now do the following...
a. Select Layer1 than click on ‘Show’ 
b. Select Layer2 and click on ‘Hide’ then,
c. Select Layer3 and click on ‘Hide’.
	 This action will make Layer2 and Layer3 disappear and show Layer1 while you 
move your mouse out of the Image1. Also do not forget to change the Events to 
onMouseOut. 
	 Repeat step 5 with Image2 also. Now you should get the Behavior Inspector 
like this Image, showing all the Events for both Image1 & Image2. 

Benny Alexander is lead developer with Macronimous.com, an offshore web design 

company focusing on quality Web and PDA application development services at low 

costs and serving the needs of small to medium businesses. 

Benny@macronimous.com
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acromedia Flash 
Communication Server 
MX (popularly referred to 
as Flashcom) is becom-

ing an increasingly popular platform 
for the efficient delivery of streaming 
video to large audiences. Many content 
delivery networks such as Speedera 
and Vitalstream have teamed up with 
Macromedia to offer their clients a 
platform to stream prerecorded videos 
easily and efficiently. However, the Flash 
Communication Server capabilities do 
by no means end there. The platform is 
also an ideal choice to deliver live-event 
broadcasts in real time across the globe 
– all through a familiar and v ery acces-
sible Macromedia Flash front end.
	 In this article I will walk you through 
the development of a simple live broad-
cast application which captures your 
local microphone and camera sources 
and publishes them with the help of 
Flash Communication Server over the 
Internet. You will also learn how to build 
a player that is capable of subscribing to 
the broadcast and playing it back to your 
viewers. 
	 Note: The sample FLA files are not 

needed to complete this tutorial but are 
provided for reference in case of any 
problems.

Creating the Server-side 
Application
	 To set up an application on your Flash 
Communication Server, all you need to 
do is to create a folder inside your server’s 
application directory. Most applications 
will also require some server-side code, 
usually in the form of a main.asc file. 
However, since this is a very basic appli-
cation, you do not need any server-side 
code at all. 
	 To create your application, simply 
create a new folder inside your Flash 
Communication Server application direc-
tory, and call it livecast. On Windows, this 
folder’s default location is C:\Program 
Files\Macromedia\Flash Communication 
Server MX\applications\.
	 Note: There is no need to restart your 
server or vhost at this point. Remember, 
however, that every time you make chang-
es to any server-side code you must restart 
the application that you have modified, or 
else you will not see your code changes 
reflected in your application logic.

Building the Live Video 
Broadcaster
	 Both applications that you are about 
to build are very similar. Each one will 
connect to your Flash Communication 
Server application and stream audio and 
video data. The main difference between 
the two files is that the broadcaster will 
publish the video and audio whereas 
the receiver – you guessed it – receives 
it. Therefore the broadcaster will contain 
a little more code than the receiver, 
because it needs to access your camera 
and microphone as well as handle the 
NetConnection and NetStream objects. 
	 Building the live video broadcaster 
involves the following steps:
1.	 Creating a new FLA file 
2.	 Laying out the user interface 
3.	 Connecting to your Flash 

Communication Server application 
4.	 Creating a NetStream object and pub-

lishing your stream 

Step 1: Create a New FLA 
File
	 Open Flash MX 2004 and choose File 
> New or press Control+N to create a new 
FLA file. Rename your existing layer to 
UI. Create a new layer above your exist-
ing layer and name it actions. Save your 
FLA file in a directory of your choice and 
name it broadcaster.fla.

Step 2: Lay Out the User 
Interface
	 Select Window > Development Panels 
> Components or press Control+F7 to 
open the components panel. Next drag 
the following components onto the 
Stage:
•	 Two TextInput components 
•	 One TextArea component 
•	 Three Label components 
•	 Two Button components 

	 Open your library (by selecting 
Window > Library or pressing Control+L) 

Building a Simple Live Video 
Broadcaster and Receiver

Learn how to leverage the power of Flash Communication
Server MX to add video and audio communications to your Flash apps

by stefan richter
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and add a new video object to it. To cre-
ate a new video object, click the little but-
ton in the top right corner of your Library 
panel and select New Video (see Figure 
1). 
	 You will see a new symbol Embedded 
Video 1, in your library. Drag it onto the 
Stage and give it an instance name of 
myvid. Later you will display your local 
camera feed inside this video object. I 
also drew a thin outline around the video 
object in my application to make it visible 
before a video is being displayed. This 
border is optional.
	 Name one of your buttons on the 
Stage connect_pb and give it a label of 
Connect. Name the second button start-
stop_pb and give this one a label of Start 
Broadcast. 
	 Give your label components the text 
properties of rtmp address for the first 
component, stream name for the second 
component, and status output for the 
third component. The label components 
simply clarify the purpose of your text 
input and text area components. You can 
omit the labels altogether if you want, 
because they play no significant role in 
the actual application logic.
	 Give the two TextInput components 
instance names of rtmp_txt and stream-
name_txt, respectively.
	 Name the text area component sta-
tus_txt; you will be using it to output 
status and trace information.
	 Align all these elements as you see fit, 
or use my layout (see Figure 2).
 
Step 3: Connect to Your 
Flash Communication 
Server Application
	 To successfully connect to a Flash 
Communication Server application 
instance, you must:
1.	 Create a NetConnection object. 
2.	 Define an onStatus() method for it. 
3.	 Call the NetConnection object’s con-

nect() method. 
	 Select Frame 1 of the actions layer 
and add the following code to it:

startstop_pb.enabled = false;

connect_pb.onRelease = function(){

    if(this.label == “Connect”){

        status_txt.text += 

“Connecting...” + newline;

        this.label = “Disconnect”;

        nc.connect(rtmp_txt.text);

    } else {

        status_txt.text += 

“Disconnecting.” + newline;

        this.label = “Connect”;

        startstop_pb.enabled = false;

        nc.close();

    }

}

nc = new NetConnection();

nc.onStatus = function(info) {

    status_txt.text += “NC.onStatus> 

info.code: “ + info.code + newline;

    if (info.code == “NetConnection.

Connect.Success”) {

        status_txt.text += “Connected 

to “ + this.uri + newline;

        startstop_pb.enabled = true;

    } else if (info.code == 

“NetConnection.Connect.Closed”) {

        startstop_pb.enabled = false;

        startstop_pb.label = “Start 

Broadcast”;

        myvid.attachVideo(null);

         myvid.clear();

    }

}

	 This code initiates the following 
actions. First it disables the startstop_pb 
button instance. You will enable it again 
after a successful connection to the 
server has been established. 
	 Next comes the onRelease function 
for the connect_pb button instance. This 
code emulates a toggle state so that the 
button can be used to both connect and 

disconnect based on the current label. At 
the same time the code outputs status 
messages into the status_txt field on the 
Stage to help you visualize what’s hap-
pening behind the scenes. The following 
code will disable the broadcast button 
when you close the connection to your 
server:

startstop_pb.enabled = false

The actual connection to Flash 

Communication Server is triggered by 

this line:

nc.connect(rtmp_txt.text);

	 As you may have noticed, this code 
grabs whatever text is currently displayed 
in the rtmp_txt text input field and pass-
es it as a parameter to the NetConnection 
object’s connect method. This enables 
you to connect to different servers (or 
applications) without having to hard code 
connection strings into the SWF file. If it 
makes live easier for you, then you can 
easily prefill the value for this input field 
inside the Flash authoring environment: 
Just highlight the component on the 
Stage, bring up the Properties panel and 
fill in the text value. Note that you must 
use the complete rtmp string to your 
server, including rtmp:/ or rtmp://.
	 At the bottom of this code block 
is the onStatus function for your 
NetConnection object. This function 
listens for a NetConnection.Connect.
Success message and, after receiving 
one, enables the startstop_pb button 
instance as you are now ready to create a 
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NetStream function and start broadcast-
ing.
	 The last code block disables the 
broadcast button and resets its label 
in case you get disconnected, either 
because you have chosen to or maybe 
because the connection has dropped for 
unknown reasons. It also cleans up the 
video object on the Stage by issuing the 
following:

myvid.attachVideo(null);

myvid.clear();

Step 4: Create a NetStream 
Object and Publish the 
Stream
	 You will create a NetStream object 
after the startstop_pb button is clicked. 
The name for the stream will be based on 
whatever value the streamname_txt text 
field holds. 
	 Add the following code underneath 
the existing code in frame 1:

startstop_pb.onRelease = function(){

    if (this.label == “Start 

Broadcast”){

        status_txt.text += “Starting 

broadcast” + newline;

        this.label = “Stop 

Broadcast”;

        ns = new NetStream(nc);

        ns.onStatus = function(info) 

{

            status_txt.text += “NS.

onStatus> info.code: “ + info.code + 

newline;

        

}

        

mycam = Camera.get();

        mycam.setQuality(25600, 0);

        mymic = Microphone.get();

        mymic.setRate(11);

        ns.attachVideo(mycam);

        ns.attachAudio(mymic);

        myvid.attachVideo(mycam);

        ns.publish(streamname_txt.

text, “live”);

    } else {

        status_txt.text += “Stopping 

broadcast” + newline;

        this.label = “Start 

Broadcast”;

        myvid.attachVideo(null);

        myvid.clear();

        ns.close();

    }    

}

	 This code is fairly self-explanatory:
1.	 First (if the current button label is 

Start Broadcast) it creates a new 
NetStream object on our existing 
NetConnection object (ns = new 
NetStream(nc);). 

2.	 It then adds an onStatus handler (ns.
onStatus = function(info)[...]), which 
enables you to see trace output inside 
the status_txt text area. 

3.	 Next, it grabs a reference to the default 
camera that’s installed mycam = 
Camera.get(); and calls the setQuality 
method with a parameter of 25600 
bytes and 0 (best possible) image qual-
ity at that given bandwidth mycam.
setQuality(25600, 0);. Feel free to adjust 
these settings as you see fit. 

4.	 Next comes the equivalent action for 
the default microphone:

5.	 mymic = Microphone.get(); 
	 mymic.setRate(11);
6.	 To be able to send audio and video 

across the Internet, you must attach 
both sources to the NetStream object:

7.	 ns.attachVideo(mycam); 
ns.attachAudio(mymic);

8.	 Now you need to attach the local 
camera feed to the video object on 
the Stage. This will enable you to see 
the feed that you will be broadcasting. 
myvid.attachVideo(mycam);

9.	 By calling ns.publish(streamname_
txt.text, “live”) you start the broad-
cast. You can omit the parameter 
“live” if you want, because the pub-
lish method would actually default 
to a live stream. However, using this 
parameter makes matters a little 
clearer I think. 

	 For more information on setQual-
ity, setRate and all the other Flash 
Communication Server–related objects 
and methods you should consult the 
excellent Flash Communication Server 
Documentation and Live Docs.
	 You are now ready for your first test 
run. Press Control+Enter or select Control 
> Test Movie to see what happens. Enter 
a valid rtmp address into the first text 
box (for example, rtmp:/livecast for local 
servers or rtmp://yourserver.com/livecast 
for remote servers), as well as a stream 
name into the text box below below. 
Click Connect. Your screen should look 
somewhat similar to Figure 3 (the cheeky 
grin is optional).
 	 Did it work? Great. Pat yourself on 
the back—now let’s build the live video 
receiver.

Building the Live Video 
Receiver
	 The receiver is simply an adaptation 
of the broadcasting application. Make 
sure you save the broadcaster.fla file and 
then save a copy under the new name of 
receiver.fla. 
	 Here’s what your receiver needs to do: 
1.	 Connect to Flash Communication 

Server. 
2.	 Create a receiving NetStream object. 
3.	 Display the stream. Sounds like you 

merely need to strip back some func-
tionality rather than add anything new. 
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	 Start by removing the startstop_pb 
button, because you no longer need 
it. You can also remove the accompa-
nying function from your code. You 
should delete startstop_pb.enabled = 
false on line 1 as well as the startstop_
pb.onRelease function at the bottom of 
your code.
	 Also, the connect_pb.onRelease func-
tion can be stripped of the following line:

startstop_pb.enabled = false; 

	 In fact, you can remove any references 
to startstop_pb. 

connect_pb.onRelease = function(){

    if(this.label == “Connect”){

        status_txt.text += 

“Connecting...” + newline;

        this.label = “Disconnect”;

        nc.connect(rtmp_txt.text);

    } else {

        status_txt.text += 

“Disconnecting.” + newline;

        this.label = “Connect”;

        nc.close();

    }

}

	 The NetConnection object’s onStatus 
handler also needs some minor modifica-
tions. After a “NetConnection.Connect.
Success” message is received, you need to 
create a NetStream object, add an onSta-
tus handler to it (in order to see some 
trace output on the Stage) and attach 
the stream to your video object (myvid.
attachVideo(ns)) in order to display the 
feed. There is no need to anything simi-
lar to the microphone or sound object, 
because the sound that is broadcast is 
contained within the same NetStream 
object. Therefore attachVideo in this 
case actually means attaching video and 
sound.
	 To finish, add the ns.play command at 
the end. Here’s the completed code:

nc = new NetConnection();

nc.onStatus = function(info) {

    status_txt.text += “NC.onStatus> 

info.code: “ + info.code + newline;

    if (info.code == “NetConnection.

Connect.Success”) {

        status_txt.text = “Connected 

to “ + this.uri + newline;

        ns = new NetStream(nc);

        ns.onStatus = function(info) 

{

            status_txt.text += “NS.

onStatus> info.code: “ + info.code + 

newline;

        }

        myvid.attachVideo(ns);

        ns.play(streamname_txt.text, 

-1)

    }

}

	 As you can see instead of attach-
ing a camera and microphone to the 
NetStream object we instead call the play 
method and pass it the current value of 
streamname_txt as its first parameter. Of 
course this parameter (the name of the 
stream which should be played back) 
needs to match the name of the stream 
you will be broadcasting through the 
broadcaster application.
	 Time for another pat on the shoulder 
– you are now ready to go on the air.

Lights, Camera, Action
	 Publish both movies, then open 
them side by side. You can either use 
two browser windows or two standalone 
Flash Player applications – the choice is 
yours.
	 Press the Connect button in both 
applications, followed by the Start 
Broadcast button in your broadcaster 
application. If you followed my directions, 
then your screen should look similar to 
Figure 4 (minus that funny-looking guy 
with glasses).
	 If you are having problems connect-
ing to your server or the application isn’t 
working as expected, then don’t worry – 
you can download the completed source 
files from page 1 of this tutorial, and you 
can modify those to suit your needs. 
	 First, however, make sure that you are 
using the correct rtmp string and that 
the server you are trying to connect to is 
actually running. Don’t laugh, it happens 
all the time.

Where to Go from Here 
	 The example in this tutorial should 
give you a good basis for additional 
features. You may want to add a slider 
component to change your camera’s 
broadcast settings on the fly. Or how 
about adding a NetStream.send com-
mand to send text information across the 

live stream? Or even simpler, try adding a 
microphone mute button, which enables 
you to start and stop audio transmissions 
independently from the video stream.
	 Please visit my forum at http://www.
flashcomguru.com/forum/default.asp 
where you will find a thread accompany-
ing this article.  
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Visual Programming in 
Macromedia Flash
	 As a visual programmer, you may 
have already tried your hand at a previ-
ous version of Flash – and been you were 
likely confused and overwhelmed by it. 
Flash has never been more inherently 
complex than Visual Basic 6, Visual Studio 
.NET, or Delphi, but it comes from a 
lineage of animation tools, not program-
ming tools. This fundamental difference 
made Flash an impractical tool for visual 
programmers until Flash MX Professional 
2004 came along and changed all that.
	 Flash 1 and 2 refined and improved 
the animation capabilities of the product. 
Flash 3 added the ability to individually 
animate movie clips and create stand-
alone EXE files – the platform’s first 
foray out of the browser. Flash 4 and 5 
contributed major improvements to its 
scripting capabilities (called ActionScript), 
including XML support. Flash MX boasted 
more ECMA-compliant scripting, includ-
ing objects and events, pre-built UI 
components like buttons and sliders, 
and a series of impressive add-ons for 
multiuser applications (Macromedia Flash 
Communication Server) and distributed 
application support (Macromedia Flash 
Remoting MX).
	 Despite these improvements, Flash 
development still required timeline-
based authoring and manual coding. 
So Flash MX Professional added sev-
eral major changes to Flash application 
authoring that helped visual program-
mers start creating their own Rich 
Internet Applications.
	 With 97 percent worldwide web 
browser penetration, Flash content 
can be viewed on almost any platform, 
including web, wireless, embedded 
devices, and – with Macromedia Central 
– on desktops. While platforms like Java 
and .NET promise code reuse for mobile 
development, Flash makes code truly 
reusable across platforms, especially on 
mobile devices. 
	 Flash code is truly reusable, unlike 
Java code, which developers must often 
tweak for each platform (although the 
Flash Player is not available on as many 
mobile platforms as Java is). You can also 
move Flash applications among platforms 
without redesigning or recoding them, 
unlike other tools such as Visual Studio 
.NET mobile web forms.

Building Flash Form 
Screens
	 The biggest change in Flash MX 
Professional was the addition of a true 
visual programming environment. Prior 
versions of Flash provided no way to eas-
ily define application screens like a login 
form or a display window. Flash develop-
ers had to kludge application screens 
into labeled Timeline keyframes or create 
custom movie clips that acted like appli-
cation screens. Flash form applications 
make it possible to create structured 
applications that are independent of the 
Timeline. 
	 Visual programmers familiar with 
Visual Basic, Delphi, and other environ-
ments will immediately notice how much 
more approachable forms make the Flash 
platform. As in Visual Basic, you can cre-
ate a form quickly and add UI and data 
components to the form by dragging 
them from a toolbar in the IDE. Since 
Flash content lives primarily within web 
browsers and other containers, a Flash 
form is really a screen within the applica-
tion, not a Windows form. You can use 
ActionScript commands to show and 
hide forms in your Flash application and 
control objects within them.
	 Another major difference between 
Windows forms and Flash form screens is 
that the latter are hierarchical and inher-
ited (see Figure 1). When you create a 
form within a form, the child form inherits 
all the elements of its parent. Hierarchical 
forms take a bit of getting used to for 
Windows forms designers but the benefit 
is striking. 
	 In VB, Delphi, and other environments, 
creating different areas that occupy the 
same form can be a nuisance (see Figure 
2). Typically you use a Windows frame 
control to house different elements, but 
then you may have trouble viewing them 
in the designer. Hierarchical forms make 
it easy to move between subsections of a 
screen without the effort. 
	 Here’s how you create the framework 
for the Flash form application:
1.	 In Flash MX Professional, choose File > 

New and select Flash Form Application. 
This creates a default application with 
two nested form screens. 

2.	 Change the instance name (in the 
Property inspector) of form1 to frm-
Search. This form will contain the main 
search interface. 

3.	 Right-click (Control-click) frmSearch 
and choose Insert Nested Screen. This 
creates a new form screen called form2 
underneath frmSearch. Change the 
instance name of the new form screen 
to frmLoading. 

4.	 Now you can add UI components (the 
equivalent of VB controls) to the forms. 
The application form is the parent of 
all the other forms in the application; 
anything you put on that form will 
also appear on any of its child forms. 
For this application, I placed a Google 
graphic in the upper left corner to 
show how this works. 

5.	 Select the frmSearch form. In the 
Components panel, drag a Label, 
Button TextInput, and TextArea com-
ponent onto the Stage. Arrange the 
components as shown in Figure 3. 
(Right-click and choose Free Transform 
to resize the components.) 

6.	 Using the Property inspector, give the 
components the following instance 
names – Label: lblSearchTime; Button: 
btnSearch; TextInput: txtQuery; and 
TextArea: txtResults. 

 
Authoring Animations
	 You may have been intimidated at the 
prospect of authoring animations in Flash 
because the Timeline and drawing ele-
ments required a designer’s skills. Besides 
getting such built-in Timeline effects as 
drop shadows in Flash MX Professional, 
you can animate elements in Flash forms 
as easily as you can animate objects in 
PowerPoint. You can also author your 
own motion graphics using movie clips 
and the standard Timeline. If not, the 
Timeline stays neatly out of the way.
	 Here’s how you add a simple animat-
ed element to the application. For these 
purposes, add a “loading” element that 
lets the user know the search is execut-
ing:
1.	 Select the frmLoading form screen. 
2.	 In the bottom right corner, add a 

graphical or text element that indicates 
“loading progress” to the user (see 
Figure 4). I added a barber pole–style 
progress bar that I made in a movie 
clip. You could just add a text tool 
element (that says “Loading...”), then 
add a Timeline Effect. To do this, right 
click the text tool element you created 
(control click on Mac) and choose > 
Timeline Effects > Effects and then 
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your selected effect to create an ani-
mation without any authoring at all. 

3.	 Hide frmLoading by selecting it and 
changing the visible property in the 
Parameters inspector to false. This pre-
vents the loading widget from appear-
ing by default. Later you’ll make this 
screen visible with ActionScript while 
the search is executing. 

 

Connecting to Data Sources 
with Components
	 Flash MX Professional sports a new 
component architecture, both for UI com-
ponents and the new data components. 
In Flash, components aren’t compiled 
code libraries like DLLs. Rather, they are 
equivalent to controls in VB or Delphi. 
Flash Professional adds XMLConnector 
and WebServiceConnector components 
to automate the interfaces with these 
two common data sources.
	 New component bindings allow you 
to define inputs and outputs for data 
components. Using the visual design 
panels built into the IDE, you wire 
XMLConnector or WebServiceConnector 
parameters directly to UI components in 
your forms. Flash features a Parameter tab 
on the Component inspector that works 
just like the property pages in VB. 

	 Here’s how you use these techniques 
to connect your application to the 
Google search service:
1.	 Drag a WebServiceConnector compo-

nent from the Components panel to 
the frmSearch form screen. It doesn’t 
matter where you put it; the compo-
nent won’t be visible in the published 
application. Give the component an 
instance name of GoogleSearch. 

2.	 Select the GoogleSearch component 
and open the Component inspec-
tor. This is where you establish the 
web service settings. Select the 
Parameters tab and set the WSDLURL 
parameter to Google’s WSDL URI (as 
of this writing, it’s http://api.google.
com/GoogleSearch.wsdl). Flash auto-
matically queries the service and 
retrieves its available operations. From 
the operations pop-up menu, select 
doGoogleSearch (see Figure 5). 

3.	 Select the Bindings tab in the 
Component inspector. This panel 
allows you to bind the web service 
inputs and outputs directly to a UI 
component in the application. Click 
the + icon to choose which parameters 
to bind. Input parameters are indicated 
by a right arrow and output param-
eters by a left arrow (see Figure 6). 
The Google interface requires all these 
input parameters, so add those one by 
one to the bindings list. Because you’re 
also binding one output parameter, 
results.searchTime, add it to the list. 

4.	 For each binding in the list, you 
need to set a UI component, a vari-
able reference, or a literal value to 
pass to or from the web service. First 
select params.q from the binding list 
– the search query string to pass to 
the Google service. To bind it to the 
TextInput component on the frm-
Search form, click the “find” icon in the 
Bound To row. Flash opens the Bound 
To dialog box, which displays a hierar-
chical list of components in your appli-
cation. Find the txtQuery component 
instance, select it, and click OK (shown 
in Figure 7). 

5.	 Fill in the rest of the input parameters 
for the Google service. The other 
parameters can take literal inputs. To 
define a literal input, follow the same 
procedure as in Step 4, except in the 
Bound To dialog check Use Constant 
Value and enter the literal into the cor-

params.key		  [Your Google Web API License Key]

params.start 		  0

params.maxResults		  10

params.filter		  true

params.restrict		  [empty string]

params.safeSearch		  true

params.lr			  [empty string]

params.ie			  [empty string]

params.oe			  [empty string]
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responding text box. Listing 1 shows 
what values to use for each input 
parameter. 

6.	 Repeat Step 4 for the results.searchTime 
output parameter, binding it to the lbl-
SearchTime component instance on frm-
Search. The component system allows 
you to format the input or output before 
binding. Since the searchTime parameter 
is just a floating-point number, format 
this value to make it more intelligible 
to users. From the Formatter pop-up 
menu, select Compose String. Then click 
Formatter Options, and enter the follow-
ing string into the dialog box:

Search time: <.> seconds
	 The parameter value will be substi-
tuted for the <.> placeholder when the 
component binds.
	 Note: By default, Macromedia Flash 
Player security restrictions prohibit Flash 
movies from accessing web services that 
reside outside the exact domain of the 
SWF attempting to access those web 
services. This restriction does not apply 
to SWFs that are run locally off your hard 
drive, only those that originate from a 
web server. A SWF can access a cross-
domain web service if the server hosting 
that service contains a security policy file. 
Attaching Script Actions
	 Macromedia Flash MX 2004 features 
a new version of the application’s native 
scripting language. ActionScript 2 is 
object-oriented and complies with ECMA-
262 Edition 4. Still, visual programmers 
need to become familiar with the unique 
way that Flash attaches script actions to 
events in the application.
	 New behaviors make the process of trig-
gering scripted UI component events much 
easier than in previous versions of Flash. 
	 Here’s how you use a behavior to 
trigger the web service and display its 
results:
1.	 Click the btnSearch button on 

frmSearch. In the Behaviors panel, 
click the + icon and choose Data > 
Trigger Data Source. In the result-
ing dialog box, select GoogleSearch 
WebServiceConnector and click OK 
(see Figure 8). 

2.	 With btnSearch still selected, open 
the Actions panel. You’ll see that Flash 
automatically added the code to trig-
ger the web service when the user 
clicks the Search button. 

3.	 Any web service output you don’t bind 
in the Component inspector needs to 
be managed with code. Just before the 
trigger event, add the code in Listing 
2. These event listeners allow you to 
intercept the web service’s send and 
result events and perform additional 
operations with ActionScript. 

on (click) {

	// Trigger Data Source Behavior

	// Macromedia 2003

	this._parent.GoogleSearch.

addEventListener(“send”, onGoogle-

Search);

	this._parent.GoogleSearch.addEventLis

tener(“result”, onGoogleSearchResult);

	this._parent.GoogleSearch.trigger();

}

4.	 Add the ActionScript functions that 
handle these events. The code in Listing 
3 does some interface work like enabling 
and disabling components while the 
search is in progress. Most importantly 
it iterates through the results returned 
from Google, formats them using HTML, 
and displays them in the txtResults 
TextArea instance (make sure you set 
txtResults’ HTML parameter to true in 
the Component Inspector to display the 
HTML properly). If you want to change 
the data or formatting, consult the Web 
Services panel to see the output param-
eter schema returned from the doGoog-
leSearch operation. 

on (click) {

	

	var onGoogleSearch = function()

	{

		// Show the barber pole and disable 
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search

		_root.application.frmSearch.frmLoad-

ing.visible = true;

		this._parent.txtResults.text = “”;

		this._parent.lblSearchTime.text = “”;

		this.enabled = false;

		this._parent.txtQuery.enabled = 

false;

	}

	

	var onGoogleSearchResult = function()

	{

		var res = this._parent.GoogleSearch.

results.resultElements; // shorthand

	

	

for (var i = 0; i < res.

length; i++) 

		{

			var s = “”;

			s += “<a href=\”” + 

res[i].URL + “\”><font 

size=\”+1\”color=\

”#0000FF\”><u>” + res[i].

title + “</u></font></

a><br>”;

			s += res[i].snippet + 

“<br>”;

			if (res[i].summary != “”) { 

s += “<font color=\”#999999\

”>Description:</font>” + res[i].sum-

mary + “<br>”; }

		s += “<a href=\”” + res[i].URL + 

“\”><font color=\”#009900\”><u>” + 

res[i].URL + </u></font></a> - “ + 

res[i].cachedSize;

		s += “<br><br>”;

			this._parent.txtResults.text += s;

		}

		// Hide the barber pole and reenable 

the search

		_root.application.frmSearch.frmLoad-

ing.visible = false;

		this.enabled = true;

		this._parent.txtQuery.enabled = true;

	}

	

	// Trigger Data Source Behavior

	// Macromedia 2003

	this._parent.GoogleSearch.

addEventListener(“send”, onGoogle-

Search);

	this._parent.GoogleSearch.addEventLis

tener(“result”, onGoogleSearchResult);

	this._parent.GoogleSearch.trigger();

}

	 You’re ready to publish your appli-
cation. Publishing is the equivalent of 
building or compiling in Visual Studio and 
other IDEs. Select File > Publish or just 
press Control-Enter to publish using the 
default settings. 
	 Now try out some Google searches!

Benefits of Flash
	 Let’s review the benefits of Flash MX 
Professional as a visual programming 
environment:
•	 More like the visual programming 

environment you know. There’s no deny-
ing that Flash has a long heritage as a 

design and animation tool. With Flash 
MX Professional visual programmers can 
build visual applications that can – but 
don’t need to – take advantage of the 
rich media capabilities of Flash. Forms, 
object-oriented ECMA-262–compliant 
ActionScript, components, and events 
make Flash programming more like VB 
programming than ever before. With 
unique rich media capabilities at your 
fingertips, Flash offers a lot more than 
traditional visual programming tools. 

•	 Rich applications. Even if you’re not a 
designer, you can take advantage of easy-
to-use Timeline effects and behaviors to 
add motion graphics to your form appli-
cations. Try doing this in Visual Basic! 

•	 True cross-platform, cross-device com-
patibility. Flash content can be viewed 
on almost any platform, including web, 
wireless, embedded devices, and (with 
Macromedia Central) on the desktop. 
Flash code is more reusable than Java 
code. You can move Flash applications 
among platforms without significant 
redesigning or recoding. For instance, 
converting the Google search applica-
tion so it works on mobile devices or 
handhelds that support Flash Player 
7 requires nothing more than resizing 
or rearranging the components on the 
Stage to fit a smaller screen size. 

		    Macromedia Flash MX Professional 
is not a replacement for a Windows 
application IDE like Delphi or Visual 
Studio. However, visual programmers 
who want to author rich applications 
for deployment online, on handhelds, 
or on devices will discover familiar 
scenery in this new version of Flash.

References
	 Google API: www.google.com/apis/ 
	 To examine the entire project, down-
load the FLA source file:
•	  google_web_api.zip (1.4 MB)  
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e probably all know 
by now how to play a 
progressive FLV without 
Flashcom:

nc = new NetConnection();

nc.connect(null);

ns = new NetStream(my_nc);

ns.setBufferTime(0.1); // small buffer 

to limit motion in preview 

my_video.attachVideo(ns); // my_video 

is a video object on stage 

ns.play(thefile);

	 To turn this example into a thumbnail 
preview of the actual FLV you could do 
this:

ns.onStatus = function (info) {

     if(info.code == “NetStream.

Buffer.Full”){

          ns.pause();

     } 

};

	 There’s even a way of supressing the 
sound resulting in a silent preview:

// soundholder is a simple movieclip 

on stage 

soundholder.attachAudio(ns);

audio = new Sound(soundholder);

audio.setVolume(0); 

	 You don’t have to be a rocket scien-
tist to take this example further using a 
‘play’ button and kicking the video plus 
sound into life upon click.  But what’s not 
so obvious is the fact that even if you 
pause the video, the FLV file will load in 
its entirety in the background, potentially 
clogging up a user’s connection. This is 
even more of an issue if you want to dis-
play many previews at once.
	 I found out about this behavior using 
a neat little program called Netlimiter 
(http://www.netlimiter.com/). It allows 
you to see which applications are using 
what kind of bandwidth and it also 
enables you to throttle a fast connection 
on a per application basis, emulating 
dialup users for example.
	 I thought it would be easy enough to 
stop the FLV downloading by killing the 
NetConnection or close the NetStream 
similar to how this would work using 
Flashcom. Unfortunately I had no success 
with that approach, the FLV would con-
tinue downloading come what may.
	 Fortunately the workaround was sur-
prisingly easy: try loading a non-existing 
FLV. Here’s the code I used: 

ns.onStatus = function (info) {

     if(info.code == “NetStream.

Buffer.Full”){

          my_video.attachVideo(null);

          ns.pause();

          ns.play(“nonexist.flv”);

     } 

}; 

	 This seems to do the trick quite nicely, 
showing one frame of the previously 
loaded FLV without clearing the video 
object. A typical preview consumed only 
about 5 to 10 KB of data -- a big saving 
over a whole flv file which is potentially 
several MB in size. 
	 The source for the finished example 
is here: http://www.flashcomguru.co.uk/
downloads/flv_preview.zip 
	 The sourcecode is a bit messy but I 
didn’t have time to clean it up. 
	 Let me emphasize again: if you only 
have a single FLV file on your page then 
the background download can be a great 
feature and even improve the user expe-
rience. But if you want to preview many 
different FLV files on one page then I rec-
ommend you use my approach above. 
	 Hope this helps someone.  
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A workaround involving loading a non-existing FLV
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DrawingArt
rawingArt is a reference 
portfolio made in Flash-

XML by Slovenian Web 
artist Miroslav Koljanin. He 
started his mission in Web 
design and development 

of advanced Web sites two 
years ago and since then he 
has built and designed a lot 

of Web sites using Flash-XML, 
HTML, PHP, ASP, CFM, MySQL, 

and CSS technologies. The 
DrawingArt Web site presents 
only picked-up works so that 
visitors can get an impresion 

of the knowledge and experi-
ences of that Web designer. 
The design itself presents a 
bit of a retro/old look with 
some techy use of buttons 

and its content showcase. We 
can also expect a new rede-

sign of the DrawingArt page 
soon in the first half of 2006. 

www.drawingart.org   
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